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Warranty

All products manufactured by ICP DAS are under warranty
regarding defective materials for a period of one year, beginning
from the date of delivery to the original purchaser.

Warning

ICP DAS assumes no liability for any damage resulting from the
use of this product. ICP DAS reserves the right to change this
manual at any time without notice. The information furnished by
ICP DAS is believed to be accurate and reliable. However, no
responsibility is assumed by ICP DAS for its use, not for any
infringements of patents or other rights of third parties resulting
from its use.

Copyright

Copyright @ 2009 by ICP DAS Co., Ltd. All rights are reserved.

Trademark

The names used for identification only may be registered
trademarks of their respective companies.

Contact US

If you have any problem, please feel free to contact us.
You can count on us for quick response.

Email: service@icpdas.com
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1. Introduction

Experience new PAC technology

e

the most powerful control system..

WinPAC-8000 is the second generation PAC of ICPDAS. It equips a PXA270 CPU (520
MHz) running a Windows CE.NET 5.0 operating system, various connections (VGA, USB,
Ethernet, RS-232/485) and 1/4/8 slots for high performance parallel I/O modules (high
profile I-8K series) and serial-type 1/0 modules (high profile 1-87K 1/0 modules).

Its operating system, Windows CE 5.0, has many advantages, including hard real-time
capability, small core size, fast boot speed, interrupt handling at a deeper level,
achievable deterministic control and low cost. Using Windows CE.Net 5.0 in the
WInPAC-8000 gives it the ability to run PC-based Control software such as Visual
Basic.NET, Visual C#, Embedded Visual C++, SCADA software, Soft PLC ...etc

Comparing with the first generation WinCon-8000, it not only improves the CPU
performance (from 206 MHz to 520 MHz) and upgrading OS (from CE 4.1 to CE 5.0), but
also adds many reliability features, such as dual LAN, redundant power input, dual
battery backup SRAM, etc. It gives you all of the best features of both traditional PLCs
and Windows capable PCs.
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1.1. Features

Suﬂware Features

Windows CE .Net 5.0 Inside
Most of the popular features in MS software are included, such as

1. FTP Server

2. HTTP Server

3. ASP (Java script, VB script)

4. SQL Server Compact Edition 3.5
5. Compact .Net Framework 2.0

Remote Maintenance via FTP Server and VCEP Software

The FTP server is used for uploading applications or downloading data. And VCEP is
designed for managing the WinPAC-8000. VCEP can synchronize every movement
(screen, keyboard and mouse actions) between the PC and the WinPAC-8000 via the
Ethernet. By using the FTP server and VCEP, you can update and manage the
WInPAC-8000 remotely via the Ethernet.

Built-In OPC Server

NAPOPC_CES5 is an OPC server and SCADA software can easily integrate 1/0 modules
through it. Furthermore, it also provides a library which users can use to develop their
AP by eVC, C# or VB.Net.

NAPOPC_CE5 not only supports 1/0 modules in local slots, but also supports remote
I/O modules with the following protocols via the RS-232/485 or Ethernet:

1. Modbus/RTU
2. Modbus/ASCII
3. Modbus/TCP
4. DCON
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Rich Software Solutions

ISaGRAF

Indusoft

VS.net
2003
2005
2008

On the WInPAC-8000, ICP DAS provides the following software solutions to fit in
different applications.

1. Visual Studio .Net 2003/2005/2008 and eVC solution:
SDK as well as demo programs for C#, VB.Net and eVC are provided.

2. SoftPLC solution:
A. 1ISaGRAF supports IEC61131-3 languages, Ladder Diagram (LD), Structured Text
(ST), Function Block Diagram (FBD), Sequential Function Chart (SFC), Instruction
List (IL), and Flow Chart (FC).
B. KW-software supports IEC61131-3 languages and HMI features.

3. SCADA solution:
Indusoft provides simple “drag and drop”, “point and click” developing environment
for HMI and SCADA applications.
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Upgrading applications from WinCon to WinPAC just copy and play

Copy & Play

i§3| .

WinCon 8000 WinPAC 8000

Users can upgrade their controller from WinCon-8000 to WinPAC-8000, and meanwhile
still keep most of their old applications (.exe file) running smoothly on WinPAC-8000
without any modification. The only thing that users have to do is just to copy the .exe file
from WinCon-8000, paste it to WinPAC-8000, and then play it. How simple it is. And for
exceptions that old applications (.exe file) are not able to follow the copy-and-paste rule,
users can still finish the upgrading by recompiling the old applications.

Hardware Features . sed: October 2012
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Power CPU Module
The most important features of the CPU module are

1. PXA270 or compatible CPU (32-bit and 520MHz)
2. 128 MB SDRAM
3. 63 MB Built-In Flash Disk (WP-8x3x)

31 MB Built-In Flash Disk (WP-8x4x)

Built-in VGA Port

A built-in VGA port can be directly connected to a regular LCD display. Users can
operate the HMI or SCADA software (running on the WinPAC-8000) with display,
keyboard and mouse just as how they usually did on regular PCs.

64-bit Hardware Serial Number

The 64-bit hardware serial number is unique and individual. Every serial number of
WinPAC-8000 is different. Users can add a checking mechanism to their AP to prevent
software from pirating.

/O Module Hot Swap Ability

The WIinPAC-8000 features hot swap which
means that there is no need to power off the
WInPAC-8000 for replacing modules. And the OS
provides a function sending plug-in and removing
messages to user’s applications. Using this
feature, users can design its own plug-and-play
applications.

Plug & Play

2

Rich I/O Expansion Ability (RS-232/485, Ethernet, FRnet, CAN)

Beside the local I/O slots, WinPAC-8000 also equips several RS-232/485 ports, two
Ethernet ports to connect serial I/O and Ethernet I/O. And with FRnet and CAN
communication module in local slot, FRnet 1/O and CAN devices are easy to be
integrated.
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Built-In Flash Disk (31/63 MB)

In normal situation, users can store their AP or data to the Micro SD card or USB Flash
disk. But in some vibrational environment (for example, like driving ships), the two
storage media would be bad connection. Then the built-in Flash disk will be the best
storage media in such the vibrational environment.

Dual Watchdoqg Timer

A system could be hanged up when the OS or the AP fails. There are two watchdogs
(OS watchdog and AP watchdog) designed to automatically reset the CPU when the
situations happen. The design will increase the reliability of the system.

Dual Battery-Backup SRAM (512 KB)

To maintain important data while power off, non-volatile memory is the ideal design. The
WInPAC-8000 equips a 512 KB SRAM with two Li-batteries to maintain data while
power off.

The two Li-batteries can continually supply power to the 512 KB SRAM to retain the
data for 5 years; and the dual-battery design can avoid data lost while replacing a new
battery.

Dual Ethernet Ports

WInPAC-8000 provides two Ethernet ports. The two Ethernet ports can be used to
implement redundant Ethernet communication and separate Ethernet communication
(one for global Internet, one for private Ethernet).

Redundant Power Input

To prevent the WinPAC-8000 from failing by the power loss, the power module is
designed with two input connectors. Once a power input fails, the power module
switches to the other power input. And there is a relay output for informing the power
failure.

Ventilated Housing Design Allows Operation Between -25 ~ +75 C

Each WIinPAC-8000 is housed in a plastic-based box with a column-like ventilator that
can help to cool the working environment inside the box and allow the WinPAC-8000
operating between -25 °C and +75 °C
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i=8K/i-87K{series)

1.

WinPAC-8000 provides the following I/O expansion bus

Local I/O Slot

There are 1/4/8 slot options to expand local I/0. And the 1/O modules can be parallel bus
type (high profile I-8K series) and serial bus type (high profile 1-87K series).

The difference between them is

I8K Series | I87K Series _

Microprocessor Yes (8051)
Communication interface Parallel bus Serial bus
Communication speed Fast Slow

Dl latched function No Yes
Counter input (for digital input module) No Yes (100 Hz)
Power on value No Yes

Safe value No Yes
Programmable slew-rate for AO module | No Yes
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Ethernet

The available Ethernet I/O devices are ET-6000, ET-7000, 1-8KE4/8 and
[-SKE4/8-MTCP.

WinPAC-8000 can access them with Modbus/TCP or DCON protocol.

RS-485

WinPAC-8000 is equipped with two RS485 COM ports which enable the transmission
rate up to a maximum of 115.2 Kbps. The medium for connection is a twisted-pair,
multi-drop, 2-wire RS-485 network that can link i-7000, M-7000, RU-87Pn and high
profile 1-87K modules.

FRnet

FRnet is an innovative industrial field bus that has many special features, such as
high-speed deterministic 1/0O control, real I/O synchronization capabilities, non-protocol
communication, and easy programming. Plugging in an FRnet communication module
(1-8172W), the WIinPAC-8000 can link FRnet I/0O modules to implement high-speed
distributed 1/O.

CAN Bus

The Controller Area Network (CAN) is a serial communication way, which efficiently
supports distributed real-time control with a very high level of security. It provides the
error-processing mechanisms and concepts of message priority. These features can
improve the network reliability and transmission efficiency. Furthermore, CAN supplies
the multi-master capabilities, and is especially suited for networking “intelligent” devices
as well as sensors and actuators within a system or a sub-system. With 1-8120, 1-8123,
[-8124, 1-87120, 1-87123, and 1-87124, WIinPAC-8000 is able to demonstrate every
feature of CAN, CANopen, and DeviceNet.
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1.2. Specifications

System Software

oS WiInCE.Net 5.0
.Net Compact Framework 2.0
Embedded Service FTP server, Web server (supports VB script, JAVA

script), Embedded SQL server

SDK Provided DIl for eVC, DIl for Visual Studio.Net 2003/2005/2008
CPU PXA 270 or compatible (32-bit and 520 MHz)
SDRAM 128 MB

Dual Battery Backup SRAM 512 KB (for 5 years data retain)

Flash WP-8x3x:

128 MB (64 MB for OS image, 63 MB for built-in Flash
disk, 1 MB for registry)
WP-8x4x:
96 MB (64 MB for OS image, 31 MB for built-in Flash
disk, 1 MB for registry)

Expansion Flash Memory Micro SD socket with a microSD card (can support
16GB microSD card)

RTC (Real Time Clock) Year-2000 compliance; seconds, minutes, hours, date
of the month; month, year, valid up from 1980 to 2079

EEPROM 16 KB (0 ~ 8 KB for user, 9 ~ 14 KB for other
programs, 15 ~ 16 KB for OS), Data Retention: 40
years; 1,000,000 erase/write cycles

64-bit Hardware Serial Number  Yes

Dual Watchdog Timer Yes

Programmable LED Indicator 1

Rotary Switch Yes (0~ 9)

DIP Switch Yes (8 bits); for WP-8431, WP-8441, WP-8831 and
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WP-8841 only

Power

Input Range +10 ~ +30 Vpc
Isolation 1 kv
Redundant Power Inputs  Yes, with one power relay (1 A @ 24 Vpc) for alarm
Capacity WP-8131 and WP-8141.:
1.0 A, 5V supply to CPU and backplane, 0.6 A, 5V supply
to I/O expansion slots, total 30 W
WP-8431 and WP-8441.:
1.1 A, 5V supply to CPU and backplane, 4.9 A, 5V supply
to I/O expansion slots, total 30 W
WP-8831 and WP-8841:
1.2 A, 5V supply to CPU and backplane, 4.8 A, 5V supply to
I/O expansion slots, total 30 W
Consumption WP-8131 and WP-8141: 7.3 W (0.3 A @ 24 V)
WP-8431 and WP-8441: 9.1 W (0.38 A @ 24 V)
WP-8831 and WP-8841: 9.6 W (0.4 A @ 24 V)

VGA & Communication Ports

VGA WP-8x3x:
Yes, with one extra GPU
(resolution: 1024 x 768, 800 x 600, 640 x 480)
WP-8x4x:
Yes (640 x 480, 800 x 600 resolution)
Ethernet Port RJ-45 x 2, 10/100 Base-TX
(Auto-negotiating, LED indicators)

USB 1.1 (host) WP-8x3x: 2
WP-8x4x: 1
COMO (Internal RS-485 interface communication with [-87K 1/O

modules in slots) Note: CPU internal UART
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VGA & Communication Ports

Baud Rate — 115200 bps

Data Bits — 8

Parity — None, Even, Odd

Stop Bits — 1

FIFO — 1 byte

(RS-232 used to update firmware) Note: CPU internal UART
Baud Rate — 115200, 57600, 38400, 19200, 9600, 4800, 2400,
1200 bps

Data Bits — 7, 8

Parity — None, Even, Odd

Stop Bits — 1

FIFO — 1 byte

(RS-485) Note: 16C550 compatible

Baud Rate — 115200, 57600, 38400, 19200, 9600, 4800, 2400,
1200 bps

Data Bits - 5, 6, 7, 8

Parity — None, Even, Odd, Mark (Always 1), Space (Always 0)
Stop Bits — 1, 2

FIFO — 16 bytes

COMS3 (RS-232/RS-485), for WP-8431, WP-8441, WP-8831 and
com3 | WP-8841 only
R Note: 16C550 compatible
. :",;," _oate  Baud Rate — 115200, 57600, 38400, 19200, 9600, 4800, 2400,
~ ©244=TXD
eTs —=7o 5| pxp 1200 bps
SEIPEEY Data Bits - 5, 6, 7, 8
Data-—-—-l:ga:- © 54+ GND ala blts — o, o, /,
— Parity — None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits — 1, 2
FIFO — 16 bytes
Tips & Warnings

Q COMa3 can be configured as either RS-232 or
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VGA & Communication Ports

COoM4

DSR cob
RXD
L TXD
cTs
DTR
RI

GND

RS-485, that only can select one at a time and Its
configuration depends on the pin connections as
follows:

RS-232 (RXD, TXD, CTS, RTS and GND)
RS-485 (Data+ and Data-)

There is no software configuration or hardware

jumper needed.

(RS-232), for WP-8431, WP-8441, WP-8831 and WP-8841
only, Note: 16C550 compatible

Baud Rate — 115200, 57600, 38400, 19200, 9600, 4800, 2400,
1200 bps

Data Bits - 5, 6, 7, 8

Parity — None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits — 1, 2

FIFO — 16 bytes

I/O Expansion Slots

Slot Number

(supports high profile 1-8K and I-87K modules)
WP-8131 and WP-8141: 1 Slot
WP-8431/WP-8441: 4 Slots
WP8831/WP-8841: 8 Slots

Hot Plug (will be available) (supports high profile 1-87K modules only)

I/O Module Hot Swap Ability

Dimensions

WP-8131/WP-8141

95 x 132 x 111 mm
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WP-8431/WP-8441 230 x 132 x 111 mm
WP-8831/WP-8841 354 x 132 x 111 mm

Operating Environment

Operating Temperature —25°C ~ +75°C
Storage Temperature -30°C ~ +80°C
Humidity 10 ~ 90%, Non-condensing
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1.3. Dimensions

There are several series of WinPAC modules whose overviews depended on the
guantity of the slot.

All dimensions in millimeter.

Top View Front View

Right Side View Left Side View

— >————_ 1l h ol 11t
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1.4. Overview

The WInPAC contains several interfaces and peripherals that can be integrated with
external systems. Here is an overview of the components and its descriptions. The
details of these items are as follows:

LED Indicators

=D- P Rotary Switch
-+
=GND
b TxD e +———&) Micro SD Socket

=RxD

WP-8131

- o VGA Port

e R.COM
=PGND I/O Expansion Slot
= PWR2
=P.GND

=PWR1

Ethernet Port

FG.

20202 ) )

:® Connector

LED Indicators

=D- P Rotary Switch
-+
=GND
b TxD e ———&) Micro SD Socket

=RxD

WP-8141

- o VGA Port

R.COM
=PGND /O Expansion Slot
= PWR2
=PGND

=PWR1

r

FG.

USB Port

Ethernet Port

[ O e O

:® Connector
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WP-8431/WP-8831

E® Micro SD Socket

@ LED Indicators F) Rotary Switch

3 DIP Switch

) USB Port 110 Expansion Slot
WP-8441: 4 Slots
Ethernet Port WP-8841: 8 Slots

i Connector

Redundant Power
PWR2 +10 ~ +30 Voc

R.COM
j— Relay Output
R.NO
D+
} cOomz2
D.

= Frame Ground

)RR )

F.G.
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WP-8441/WP-8841

E® Micro SD Socket

@ LED Indicators b)) Rotary Switch

13 USB Port é I/O Expansion Slot
WP-8441: 4 Slots

¥ Ethernet Port WP-8841: 8 Slots

3 Connector

PWR1
GND

Redundant Power
PWR2 +10 ~ +30 Voc

GMD

R.COM
j— Relay Output
R.MO
D
} cCOmz2
D.

= Frame Ground

)R8 )

F.G,
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1. LED Indicators

The WInPAC has two LED indicators that are located near the rotary
switch and show the operation status.

LED Indicator  State (Color) Meaning

RUN ON (Red) The OS is ON
Blinking The System_disk formated
or defragmented
PWR ON (Green) The Power is ON
OFF The Power is OFF

The Rotary Switch is an operating mode selector switch which provides
seven functions related to the selection of the operating mode and
authorization control for the WinPAC.

For more information about the operating mode, please refer to “section 2.3.
Configuring the Boot Mode”

3. Micro SD Socket

There is a Micro SD expansion slot which is used to increase memory capacity just in
case 16 GB.

4. VGA Connector

The VGA connector is a 3-row 15-pin connector that can be used to
connect a monitor at a variety of supported VGA resolutions. These
resolutions range from 640 x 400 to 1280 x 1024 px.
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5. 1/0 Expansion Slot

The WInPAC includes some additional I/O slots that can be used for expansion
purposes. The number of expansion 1/O slots for each model is as follows:
WP-8141/WP-8131: 1 I/O slot

WP-8441/WP-8341: 4 1/O slots

WP-8841/WP-8831: 8 I/O slots

6. Connector

The connector has 10 pins and the pin assignments are as follows:

WP-8131/WP-8141 WP-8431/WP-8441/WP-8831/WP-8841
Description Description
@ Lo- | com2 = L PWRI |
8 Power input 1
‘ E D+ (RS-485) ﬁ L cnD
| Fono = .
‘ COM1 i Power input 2
@ "0 | (Rs-232) =] GND
=| |- B[ [
Relay output
1= = EQ| b
Relay Output
= = [
COM2: RS-485
(1= =
Power Input 2 -
=] |b =
;;T Frame Ground
(1= =
Power Input 1
@ Lewni
@ q-r Frame Ground
FG.
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COML1 (3-Pins RS-232) (for WP-8131/WP-8141 only)

Note: CPU internal UART

Baud Rate: 15200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps
Data Bits: 7, 8

Parity: None, Even, Odd

Stop Bits: 1

FIFO: 1 byte

COM2 (2-Pins RS-485) (WP-8431/WP-8441/WP-8831/WP-8841
only)

Note: 16C550 compatible

Baud Rate: 15200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps
Data Bits: 7, 8

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits: 1, 2

FIFO: 16 bytes
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7. Ethernet Port (LAN1/LAN2)

The WInPAC contains two Ethernet ports for use with network devices, and are denoted
as LAN1 and LAN2.

WP-8441/\WP-8841 WP-8431/\WP-8831

_'.[|—1m1nuru|
[ Link/Act

_'.[|—10f1uum
O Link/Act

S

Each Ethernet port has two LED indicators, which are used to indicate the network
speed and Link/Acting, as described below.

LED Indicator  State (Color) ‘ Meaning

10/100M ON (Orange) Network Speed: 100 MB
OFF Network Speed: 10 MB

Link/Act ON (Green) The Link is active
OFF The Link is inactive
Blinking(Green) Network activity
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8. USB Port

The WInPAC contains 1/2 USB port(s) that allow support for USB devices such as
mouse, keyboard or an external USB hard drive.

WP-8441/WP-8841 WP-8431/WP-8831

USB Port

9. COM1

Port Type: Female

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800,
2400, 1200 bps

Data Bits: 7, 8

Parity: None, Even, Odd

Stop Bits: 1
FIFO: 1 byte
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10. COM3 (RS-232/RS-485)

Port Type: Male

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps
Data Bits: 5, 6, 7, 8

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

COMS can be configured as either RS-232 or RS-485, but only one

Lpata+ Mode can be selected at a time and the configuration depends on
-TxD

D the pin connections as described below.
™ R

D RS-232 (RXD, TXD, CTS, RTS and GND)

RS-485 (Data+ and Data-)

No software configuration or hardware jumpers are needed.

11. COM4 (RS-232)

Port Type: Male

Baud Rate: 115200, 57600, 38400, 19200, 9600,
4800, 2400, 1200 bps

Data Bits: 5,6, 7, 8

Parity: None, Even, Odd, Mark (Always 1),
Space (Always 0)

Stop Bits: 1, 2

FIFO: 16 bytes
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Tips & Warnings

ﬂ The table below shows the data bit of each COM port and their corresponding

stop bit.
Word Length Number of Stop Bits
56,78 1
5 1.5
6,7, 8 2

12. DIP Switch (8 bits)

The DIP switch can be used to set the Module

O
ID to a number from 0 to 255. Do not use
Module ID 0 for communication. H H H H Q g Q H
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1.5. Companion CD

This package comes with a CD that provides drivers, software utility, all of the required
documentations..., etc. All of them are listed below.

L

i

Backup

Backup files related to the documents, OS images, SDKs...., etc.

Demos related to WP-8x3x/WP-8x4x

Document

Document related to WP-8x3x/WP-8x4x

— el.ogger

Demos and drivers related to eLogger

— Micro_SD

Tools and drivers related to manage the microSD

misc

Files related to miscellaneous

— 0S5_Image

0S_Image related to WP-8x3x/WP-8x4x

— PC_Tools

Tools related to management WP-8x3x/WP-8x4x that install on PC

— SDK

SDKs related to WP-8x3x/WP-8x4x

— System_Disk

Tools and drivers related to System_Diskthat install on WP-8x3x/WP-8x4x

— Update

Installation packages related to WP-8x3x/WP-8x4x updates
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1.6. Comparison of WinPAC and WinCon

WP-8x3x/WP-8x4x

WP-8x3x/WP-8x4x is the second generation of PAC. It is equipped with various
connections (VGA, USB, Ethernet, RS-232/485) and 1/4/8 slots for high performance
parallel 1/O modules (high profile 1-8K series) and serial-type 1/0 modules (high profile
[-87K 1/0O modules). Comparing to the first generation WinCon PAC, it not only improves
the CPU performance (from 206 MHz to 520 MHz), but also add many reliability
features.

COM3
RS-232/RS-485 Operating Modes Selector Dual Battery Backup SRAM COM4

RS-232

Micor SD socket

Power Indicator

WP-8831

VGA

RS-232 Analog Input/Output

8 1/0 Slots: Digital Input/Output
Motion/Timer/Counter

DIP Switch

Redundant Power

10 ~ T
1838 Vac USB Port 2
Relay Output Ethernet Port 2
COM2 /RS-485
USB Port 1

Frame Ground
Ethernet Port 1

-]
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COM3
RS-232/RS-485 Operating Modes Selector COm4

RS-232

Power Indicator |Micor SD socket

i

7P

")
T Wp-8841 -

DIP Switch

81/0 Slots:

Analog Input/Out
Digital Input/Output
Motion/Timer/Counter

Redundant Power
10 ~ 30 Voc

& Ethernet Port 2
Relay Output

COM2/RS-485

Frame Ground USB Port 1

Ethernet Port 1
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W-8x3x (Phased Out Since 2008)

W-8x3x is a PAC equipped with PC interface and 3/7 slots for I/O modules. Its PC-like
interface includes: PS/2(keyboard and mouse), VGA port , USB port and
RS-232/RS-485 communication ports. The powerful backplane(3/7 slots) can adopts
versatile ICPDAS's high performance parallel (I1-8K 1/0O modules) and serial-type 1/0
modules(I-87K I/O modules)

Use Anaog InputOutput
7 1/Q Slots: Digital InputiOutput
| MotioniTimenCountar

10 Base-T
Compact Flash
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W-8x4x

WinCon-8x4x series embedded controllers are derived from existing WinCon-8x3x
series. This evolution includes dual USB host ports to support more connectivity to USB
I/O devices, dual Ethernet 10/100M ports to provide higher network performance,
network security, and redundancy capability, and a rotate switch to configure your
system and applications.

RISC CPU 206MHZ 1

| EEPROMFRasVSDRAM uss Parelied Bus LED Inccator
| Real-time Clock use VO Expansion Siot
Watchdog Timer :

10000 Ethernet
Rovet Koy

| Urnsque Hardware SIN

[

COM Port
(RS232)

COM Port
(RS485)

Anpiog input | Anaiog output
OC Power In

Compact Flash goouw:o-oaww
elay Output
LED Indcator | oonng Rotary SW Opon Cobacton cuapd

| Counter / Frequeney
107100 Emornet | R~

I [T [T

oS Windows CE 5.0 Windows CE 5.0 Windows CE 4.1 Windows CE 4.1
CPU 520 MHz 520 MHz 206 MHz 206 MHz
SDRAM 128 MB 128 MB 64 MB 64 MB

Dual Battery 512 KB 512 KB - -

Backup SRAM

Flash 128 MB (64 MB 96 MB (64 MB for 32 MB (for OS 32 MB (for OS
for OS image, 63 OS image, 31 image only) image only)
MB for built-in MB for built-in
Flash disk, 1 MB Flash disk, 1 MB
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EEPROM
Expansion

Memory Slot

Interface

Ethernet Port

COMO

COomM1

Com2
COM3
COomM4
I/O

Slots

for registry)
16 KB

Micro SD slot
(Default=1GB)

USB1.1x2
VGA portx 1
(1024 x 768,
640 x 480, 800
X 600)

RJ45 x 2,

10/100 BaseTX
For 1-87K module
in 1/O slot
RS-232

RS-485
RS-232/485
RS-232

Expansion 1/4/8

64-bit Hardware Yes

Serial Number
Push button

Programmable
LED
Dual

Timer
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1

Watchdog Yes

for registry)
16 KB

Micro SD slot
(Default=1GB)

USB1.1x1
VGAportx 1
(640 x 480, 800 x

600)

RJ45 x 2,

10/100 BaseTX
For 1-87K module
in /O slot
RS-232

RS-485
RS-232/485
RS-232

1/4/8

Yes

Yes

Last Revised: October 2012

16 KB

Compact Flash

type I
(Default=1GB)
USB1.1x1
PS/2 port x 2
(Keyboard and
Mouse), VGA
port x 1 (320 x
240 ~ 1024 x
768)

RJ45 x1,

10BaseT

For 1-87K module
in 1/0O slot
RS-232

RS-485

0/3/7

Yes

Yes (for Reset)

Yes

16 KB

Compact Flash

type Il
(Default=1GB)
USB1.1x 2

VGA portx 1
(320 x 240 ~
1024 x 768)

RJ45 x 2,
10/100 BaseTX

For I-87K module
in 1/0 slot
RS-232

RS-485

0/3/7

Yes

Yes (For Reset)

Yes
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I T [T
Yes Yes Yes

Real Time Clock Yes

DIP Switch (8 bit) Yes Yes - -

Rotary Switch Yes (0~9) Yes (0~9) - Yes (0~F)
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2. Getting Started

This chapter describes installation, basic configuration and fundamental operating
principle needed to install and set up the WinPAC.

2.1. Mounting the Hardware

Step 1: Mounting the WinPAC

The WInPAC installation must provide proper ventilation, spacing, and grounding to
ensure the equipment will operate as specified.

A minimum clearance of 50mm between the WinPAC and the top and bottom side of the
enclosure panels must be provided.

There is a minimum of 50mm clearance between the top and bottom edges of the WinPAC and the enclosure panels.
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Step 2: Connecting power and I/O device

The diagram below shows the connections of the 1 slot of the WinPAC.

The input range of power supply is +10 ~ +30 Vnc

>
_ RoweriSupply,
+10 ~ +30 V,,

The diagram below shows the connections of 4/8 slots module of the
WinPAC.

_ PoweriSupply, [

+10 ~ +30 V¢ GND =1
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2.2. Inserting 1/0O Modules

The 1/O slots support parallel bus type (high profile I-8K series)
and serial bus type (high profile I-87K series) I/O modules.
There are more than 60 kinds of module for Al, AO,

DI, AO, counter input, frequency

input, PWM output,
motion control,
memory,
communication,
etc.

For more information about expansion module that are compatible
with the WIinPAC, please refer to

http://www.icpdas.com/products/PAC/winpac/io support list.htm

Tips & Warnings

It is recommended that the power to the WINPAC-8000 is switched off
when wring the 1/0 module which are plugging in the WINPAC-8000

slots.
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http://www.icpdas.com/products/PAC/winpac/io_support_list.htm

Step 1: Read the relevant documentation

W

Iy |
-for
| r——

Manual

The documentation for I-8K series modules is located at:

CD:\ Napdos\io_module
http://www.icpdas.com/products/PAC/winpac/io support list.htm

The documentation for I-87K series modules is located at:

CD:\ Napdos\io_module
http://www.icpdas.com/products/PAC/winpac/io support list.htm
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Step 2: Wiring Connections

All documents include the I/O module specifications, pin assignments and wiring
connections.

For example, Pin Assignments and Wiring connections for the 1-87054W module are as
follows:

Pin Assignments

DI.COMO Wi .
ire Connection
(el DIO
(o] it
WX DI2
| HEX DI3
- ol DI4
= WX DI5
= HEX! DI6
o5 — HEX DI7 Tl S i)
z: : E DO0 Logic Logic Level Low U@ IIDIX Logic Level High D@ Ok
000 — % gg; Open Collector On Open Collector Off
oot — NPN o ¥ b
oz — % 003 output ([T} = 38 Ilgt(com T ] gg ELCOM
H D04
‘;Zs 7 o] D05 Open Collector On Open Collector Off
008 — o 006 ERE “w{ 0& [[[or.com - 0& [ [ or.com
o — L) 007 : K1 < P Holx =Bk 108 ||| o
DO.GND E Do GND
DO.GND . : : | ‘ON State LEI "’l"'")' OFF State ‘é"o:}
0O i o ' as ¥
00FR HEX | DO.GND s e
HEX DO.PWR
— 08 | ||po.pwrR —— 08 | ||po.PwrR
Drive Relay 18 | [loox @L’T\E 18 | |[oox
08 | || po.GND 0& | ||po.GND
Resistance |, = 06 | ||Do.PWR ||, = 08 | ||0o.PWR
Load @TE 08 | [loox @g 08 | |[oox
06 | ||po.GND 08 | ||po.GND
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2.3. Configuring the Boot Mode

The WIinPAC has five operating modes that can be determined through a rotary switch.

The table below lists the operation mode selection.

Rotary switch position Modes of operation
Normal mode (Default)

Safe mode

Debug mode

OS update mode
Development mode
DCON_CE

VCEP

(For user)

~N (O |01 (BN |k O

l
©

Normal mode (Default)

Normal mode is the default mode of operation and the one you will use most of the time.
Use this mode for more tasks and configurations. Programs also are executed in this
mode.

Safe mode

Safe mode is a trouble shooting. The mode loads the minimum required device drivers
and system services to boot the WinPAC.

If you have malicious software or a program caused the WinPAC cannot be boot or run
the normal mode, you can boot in safe mode to solve the problem.
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Tips & Warnings

In normal mode, if the new settings are not saved when you change and
save the settings using the WinPAC Utility, to solve this problem,

perform the following steps:

Step 1: Restart the WinPAC in safe mode

Turn the rotary switch to “1”, and then restart the WinPAC.

Step 2: Start the WinPAC Utility to
restore the default settings

Start the WIinPAC Utility, and then click the
“Restore Default Settings” command and
“‘Save” command from the “File” menu

Step 3: Restart the WIinPAC in
SeEnE————— | normal mode

Turn the rotary switch to “0”, and
then restart the WinPAC.

e 579 S et rwcery Vomy

O wr e

-t e o b

.
|~

I
FTP Setting | System_ | *
Esolution : |32EI #2400 ap

Save and Reboot
Reboot without Save
Restore Default Settings

Exit
L T S tt
Alvways On Top e
Change HTTP document root directory to;
|\windows\www\wwwpub\ | E] lSetting ]
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Debug mode

Debug mode is a special environment in which program debug functions can be used in
addition to normal system functions.
Debug mode is unsupported.

OS Update mode

OS update mode is a way used to update OS. To update the WinPAC OS image, please
refer to “6.1. OS updates”

DCON_CE mode

This mode is the same as Normal mode. Besides, DCON_CE.exe will be run
automatically after booting

Tips & Warnings

DCON_CE.exe must be placed on the \System_Disk\Tools\DCON_CE,
or else DCON_CE.exe cannot be run automatically after booting.

VCEP mode

This mode is the same as Normal mode. Besides, VCEP.exe will be run automatically
after booting.

Tips & Warnings

VCEP.exe must be placed on the \System_Disk\Tools\VCEP or else
A VCEP.exe cannot be run automatically after booting.
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User mode

Rotary switch position 7, 8, 9 are reserved for user’s applications.
When WInPAC is boot with one of these rotary switch positions, it is boot at normal
mode. User’s application can check the rotary switch position to run at different mode.
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2.4. Using WinPAC Utility to manage the WinPAC

The WIinPAC Utility is a toolkit used to quickly control and configure the WinPAC.

For more detailed information on WinPAC Utility applications, please refer to
“3.5. WIinPAC Utility”

Step 1: Run the WinPAC Utility located on desktop

- Step 2: Configure IP address
42} (DHCP), FTP Server, Auto
xecution files..., etc

figuration

1 |

—————
|  System Setting || Ethernet Setting | FTP Setting | J I

Batteryl : OK Display Resohution : |32t|'24[| v
Battery2 : OK
Task Bar Setting:
(] Auko Hide
Step 3: Save and Reboot the || Alwarys On Top
WinPAC Change HTTP document rook directory bo:

[windows bl [ ... | [settng |

=8 Help Configuration |
Save '
= FTP Setting | Systern ) A0

Save and Reboot
Esolution | |32IJ *240 W

Reboot Without Save
Restore Default Settings
Exit

[T

Always On Top

Change HTTP document root directory to:

Setting

|H.windu:uws';www\.wwwpuh\. | [ ] [Setting ]
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2.5. Using DCON Utility to Configure 1/O Modules

DCON Utility is a tool kit used to quickly control and manage 1-87K series expansion 1/0O
modules.

Step 1: Run the DCON firmware on the WinPAC

The DCON firmware is located at:
\System_Disk\tools\DCON_CE\

Step 2: Run the DCON Utility on & :
the host PC Ll Run the DCON firmware

The DCON Utility can be obtained
from:

>» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\PC_Tools\DCON_ Utility\
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/pc tools/dcon utility/

>» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\PC_Tools\DCON_ Utility\
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/pc tools/dcon utility/

Step 3: Click the WIN CE button

ing fox 1- 70008000 Wodules
Luagaage  Help

" Fglliilﬂll:l 5§J.|.| Stat [ 0 End| 255 (Address 07265)
Run the DCON Utility | [T o o e 1o S

EI

Run the WINCE button

COMPort [ COoM 1 Addess [G0Tdec] |Ofhex) Breee [T5500 Pede [Thone DateBa [T Swobk [
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Step 4: Enter the IP address of the WinPAC to search the I-87K series
expansion I/O modules

[ WINCE device Connection -

1 WinCon-8000 (DCON_CE_V20X) | WinCon-8000 (DCON_CE_V¥21X)

© COM 3 (RS232/RS-485)

IP: 10.1.0.50 Connect ‘

Step 5: Select the module name that you want to configure

[l DCON_UTILITY. YER[506] The Found Out [#0 module ... =1E3
File COM Port 3earch Run Temminal Language Help

255 {Address 07255}

| Description
WinConS000 inEACE
R 115200 unﬁgn.rmmn for 87055 Module Yersion: A108
51 115200
52 115200
53 115200 i 87055
54 115200 Digf
55 115200 Dig| - Digital Output | 14 | [i*d
56 115200 Disl  |5E [cHO
57 115200 Dig| ’ R MEE (CH 7
Configuration Setting: Modbus Response Delay Time Setting
EEI— T
=
EE| Power On Value of DO, - Safe value of DO

Searching Status: Set Walue
TCPAIP Address: 10.1.0.58 Read Value
Read Value Enable WOT First

Digital Input [ 0 [ w00

LSE (CH:) MSE (CH:7)
Host Watchdog Setting

Timeout 255 (0.1 ~255sec) ™ Send Host OK Latch / Counter

[~ Enable WOT Satting Exit
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2.6. Changing the User Interface Language

The WInPAC is a Windows CE-based operating system which provides multilingual user
interface and the user interface can be set to one of multi languages.

Step 1: Open the Control Panel

@ Programms
i Favorites »
Docurnents
B Settings B Control Panel

l@, Metwork and Dial-up Connections
g, Taskbar and Start Menu...

|‘L-" Virtual CE

/
Step 2: Run the Regional Settings
E9 Step 3: Choose the display language, and then click OK
Reqgional Regional|and Language Se...
Settings
Language |Input

User Interface Language:

The option will determine the
language used for the menus, dialogs
and alerts,

Eniglish (Linited States)

€

English (United States)
Serman (Eermmarny )
F.Lissian
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Step 4: Run the WinPAC Utility located on desktop

Step 5: Save and Reboot

=8 Help Configuration |
I
Save
FTP Setting | System ‘| * |
Save and Reboot
E=olution ; |32EI * 240 e

Reboot without Save
Restore Default Settings

Exit
I_I AT T T S tt
Always On Top =T
Change HTTP document roak direckory ko;
|1windnws'gwww1wwwpub1 | [ ] [Setting ]
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2.7. Installing the Touch Panel Driver

The WinPAC provides the Touch Panel driver for PenMount, Egalax, and ELO touch
panels, and which can be obtained from WinPAC:
\System_Disk\External_device_driver\

The table below provides a list of supported models and respective device driver

names.
ADP-1080T-U penmount_usb_touch_vyyyymmdd.cab
ADP-1080T-R penmount_serial_touch_vyyyymmdd.cab
GA-700YY-USB egalax_usb_touch_vyyyymmdd.cab
GA-700YY-UOM egalax_serial_touch_vyyyymmdd.cab
ELO USB touch panel elo_usb_touch_vyyyymmdd.cab
ELO RS-232 touch panel elo_serial_touch_vyyyymmdd.cab

For more information on how to make setting of touch panel driver, please refer to:
http://www.icpdas.com/products/PAC/winpac/download/winpac _8000/download _0s_im

ages.htm
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http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_os_images.htm
http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_os_images.htm

2.8. Using Backup Utility to back up the settings and files

After saving the configuration settings for a WinPAC device following the first use, it is
recommended to use the Backup utility to back up all the data (settings and files).

Step 1: Run the Backup Utility on the WinPAC

The DCON firmware is located at:
\System_Disk\tools\Backup __utility\

backup_u...

Run the Backup Utility |

Backup Restore | Help

Step 2: Click the Backup menu

I
’

Eboot and OF [ | EEPROM
Reqistry SRAMIS12K)
[ ] System_Disk [ ]al

| Start backup | | Cancel

Backup infor mation:

BackupTime=7,/9/2010 12:09:25 PM
Language=English

Step 3: Select the options that 64-bit Searial Munber=01-40-65-04-11-00-00-71
you want to backup, 0S5 Version=1.3.0.2
. ZPL Yersion=1.0.1.0
enter text annotations 5P Varsion=l0.1.0

and then click the Start MACL address=00-00-3F-01-45-54
MAC2 address=00-00-EF-10-71-00
backup button

Annotation:

{Backup by ICP DAS)
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Warning ! | = |

Step 4: Confirm the backup Total number of backup items=3
. . Are you sure you want to backup there iterns?
options and then click Eboot and OS(Meed 32ME of space)
Feqgist
Yes button cean |
No |
Browse for, Folder
My Device
- Metwork
- Systern_Disk
- Mlicro_SD
- Recycled Step 5: Choose the folder that you
- Application Data want to save backup file and

- My Documents

- Program Files

- profiles =
- TEmp

Cancel Ok N
ckup Utility

Backup Restore Help

click the Ok button

Packing up 03 and Eboot,,, .

Step 6: Wait for process to Backup Utility =]
finish Backup Restore Help

Backup the Registry ok(2/5) A
Backuping the EEFROM......... ]
Backup the EEPROM oki{3/5)

Backuping the SRAM.........

Backup the SEAM oki4,/S5)

Backup the System_Disk oki{s/3)

Compressing the O3 and eboot file need 2 ming
Compressing System_Disk need 1 minutes
Compressing the backup file
WISE_DiskBackupt2010-04-06-11-06.zip
Compression is finish

Backuping is finish

72%

<
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2.9. A caution about using System_Disk

The System_disk is an authoritative storage device, but is not suitable for frequent
copying and deleting of files and is only suitable for storing important files that are not
changed frequently.

If files are copied and deleted frequently, the system will automatically perform a
System_Disk defragment action, which will consume the total resources of the CPU and
cause the OS not to function correctly.

When the OS System_Disk defragment action is being performed, the run LED will blink
and the defragment action icon will show in the system tray in the bottom right-hand of
the pc screen.

Note: Do not power off the WinPAC while the defragment is being performed.

Tips & Warnings

c Don not power off the WinPAC )
while the defragment is being Runting Mode [

performed.

¢+ 2 X 3~

// /" @ :g % r/

ICPDAS Tools SRR T(PSetver  Watchdog  Copy of
_nRnnt | ISR _rlat

<
Copy (2) of
ICPDAS

&7 [ = system_Disk

Show the icons b
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3. Tools and Tasks

This chapter briefly describes the functions of the WinPAC software toolkits.

Following tools has been installed on the WinPAC.

CD:\Napdos

wp-8x3x_ced0/wp-8x4x_ced0

System_Disk

Backup_ Utility

NAPOPC_CE5

RegistryEditor

RegistryViewer
Remote_display_application

SendToCOM
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e Backup_Utility

The Backup_Utility is a system backup/restore tool used to backup/restore all the data
(OS, settings and files) from/to the WinPAC/ViewPAC device.

For more information about the Backup Utility, please refer to “3.6.Bacup Utility”.

eDcomcnfg

dcomcnfg.exe for Windows CE to configure your DCOM settings.
NTLMUser.exe for Windows CE to create local NTLM accounts on the Windows CE
Device.

e DCON_CE

With Host PC running the DCON Utility, on the WinPAC, the DCON_CE program
allows user to view and monitor the status of the DCON Utility.

* ISQLW35

The ISQLW35 implements SQL server compact 3.5 Query Analyzer.

e Modbus

The Modbus provides various applications of Modbus protocol for configuring the
WinPAC.

® NAPOPC_CE5

NAPOPC_CES5 is an integrated omnibus software package, it allows user to quickly
establish a DCS control system.

For more information about the NAPOPC_CES5, please refer to “3.2. NAPOPC_CE5”.
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® RegistryEditor

The RegistryEditor allows user to editor the registry value of Windows CE Operating
System.

® RegistryViewer

The Registry Viewer allows user to view the registry value of Windows CE Operating
System.

® Remote display application

The remote display application allows user to view the display remotely of the WinPAC
on a Host PC.

® SendToCOM

The SendToCOM allows user to send/receive data to/from the expansion module via
serial port.

® TaskMgr

The TaskMgr provides details about programs and processes running on the WinPAC.

e \VCEP

The VCEP allows user to manage the WinPAC remotely on a Host PC.
For more information about the VCEP, please refer to “3.4. VCEP (Virtual CE Pro)”.

e WinPAC Utility

The WinPAC Utility provides various useful functions such as configuring Ethernet
settings, monitoring system settings and FTP services .etc for easy and quick
management.

For more information about the WinPAC Utility, please refer to “3.5. WinPAC Utility”.
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3.1. DCON Utility

DCON Utility oy

DCON Protocol
ASCIll Command

W

Y A

s\6
7188E/8000E 44y $h> N

%
.

The DCON Utility is a toolkit that help user search the network, easily to Configure the
I/0 modules and test the I/O status via the serial port (RS-232/485) or Ethernet port
(using virtual com port). It supports not only the DCON Protocol I1/O modules but also
the M Series I/0 Modules (Modbus RTU M-7K, M-87K and will support Modbus ASCII
M-87K) now.

I-87K Series

1-7000 Series 1-8000 Series

For more detailed information on WinPAC Utility applications, please refer to
“2.5. Using DCON Utility to configure the I/O modules”
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3.2. NAPOPC_CE5

NAPOPC_CES5 DA Server is a free OPC DA Server (The "OPC"
i stands for "OLE for Process Control" and the "DA" stands for " Data
m Access") working on WinPAC, ViewPAC & WinCon controllers
: provided by ICP DAS Ltd. The first standard (originally called simply
the OPC Specification and now called the Data Access Specification)
resulted from the collaboration of a number of leading worldwide automation suppliers
working in cooperation with Microsoft. Originally based on Microsoft's OLE COM
(component object model) and DCOM (distributed component object model)
technologies, the specification defined a standard set of objects, interfaces and
methods for use in process control and manufacturing automation applications to
facilitate interoperability. NAPOPC_CES5 DA Server integrates OPC, Modbus TCP Slave
and Modbus RTU Slave three kind Slave services, as well as integrates Modbus TCP
Master, Modbus RTU Master and DCON three kind Master communication protocols. It
also provides one advanced function “Rule Script” for use in the 1/O integration and
transformation, and some conditional Logic operation.

Any version before 2.1.0 of the NAPOPC_CES was named “Quicker”
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3.3. SendToCOM

The SendToCOM uses the serial port to communicate with expansion module. To use

the SendToCOM, you can send data to expansion module through the serial port, and
receive data from other device through the serial port.

For more information about these commands for communicating with expansion module,
please refer to:

CD:\Napdos\io_module\87k_high_profile_modules.htm

ICPDAS Send to COM v2.00
Connection Status

COM Port Baudrate Data Bit Parity Stop Bit Slot -
Jcomt  w|f115200 w8 & o-NonePs v |t vi|x v Close
Endstringwith  Gynone (DR (R (O®IF (IF [string |~ [#ere
Binary String Send Polling
Commands Responses O @ ; o
Current Packet Size (bytes) [ Current Packet Size (bytes) [g Auto send Internal (ms)  [sog
Total Packet Bytes 0 Total Packet Bytes 0 Start Stop Set
Packet Quantity send 0 Packet Quantity received |0 Start Time |Start Time
Clear

Stop Time  |Stop Time
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3.4. VCEP

| ICPDAS VCEP is designed

\\(€ for managing your WinPAC
anywhere. No matter where
you are, ICPDAS VCEP
provides a convenient
environment on the
Desktop PC and allows you
control your WinPAC
remotely.

ICPDAS VCEP is composed of two main components:
The “Server” which runs on WIinPAC.
The “Client" which runs on a Desktop PC.

Once a connection is established between the client and server (initiated by the client),
the client will periodically send requests for screen updates and send mouse/key click
information to the server to simulate. Each video frame is inter-compressed against the
previous frame and then intra-compressed with a modified LZW scheme to minimize the
amount of data transmitted from server to client.

For more detailed information on VCEP application, please refer to
http://www.icpdas.com/products/PAC/wincon-8000/wincon_VirtualCE.htm
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3.5. WIinPAC Utility

The WIinPAC Utility is a tool which is designed to quickly control and manage the

WinPAC.
WinPAC Utility [2.0.2.1] =]

File Help Configuration

Welcome to use WIinPAC Utility
This toal will help you 1o set WinPAC - 5000,

Display Resalution . IEIEIEI * 600 e

WinPAC
\G‘P‘; Industrial f._Ic_u?trul Products .
_“b Data Acquisition System
Batteryl : OK Task Bar Setting: [ | Auto Hide Always On Top
Batteryz : OK

Empty Deskiop
Change HTTP document root directory windowshwewwwosnwpub to:

aindoes e weaewpuib®, | [ ] [Setting]

Configure the synchronization with a time server ’ Configure ]
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3.5.1. Menu Bar

The WinPAC Utility includes the following function menu. All function menu will be
explained later.

v’ File Menu

78 Help Configuration
Save
Save and Reboot
Reboot wWithout Save
Restore Default Settings
Exit

v Help Menu

| File m Configuration

Reset Systemn to Default
Release Motes
About

v' Configuration Menu

Configuration

Import Registry Key
Export Regsitry Key
Store &l Registry Setting
Curnp Al Registry Setting
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File Menu

Help Configuration

Save

Save and Reboot
Reboot Without Save
Restore Default Settings
Exit

The menu commands Use to

Save

Saves the settings into Flash.
The new settings don’t take effect until the WinPAC
restart.

Save and Reboot

Saves the settings into Flash and restart the
WinPAC.

The new settings will take effect after the WinPAC
restart.

Reboot Without Save

Restarts the WinPAC without save the settings into
Flash.

Restore Default Settings

Restarts the settings of WIinPAC to its factory default
values.

The settings include configuration setting, network
setting, auto execution, etc.

Exit

Exits the WinPAC Utility.
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Help Menu

| File m Configuration

Reset Systern to Default
Release Notes
Ahout

The menu commands ‘ Use to

Reset System to Default | Resets the system interrupt status to default.

The operation used in the situation when the
interrupt crash.

You can select this operation to reset the interrupt
status without rebooting the device.

Release Notes Checks out what's new and the know issues.
About Displays a dialog box with information about
WinPAC Utility, including the current version and
copyright information.
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Configuration Menu

Configuration

Import Registry Key
Export Regsitry Key
Store Al Registry Setting
Durnp Al Registry Setting

The menu commands Use to

Import Registry Key Backs up a sub-key of registry by using a registration
entry (.reg) file.

How to use:

Step 1: Select the “Import Registry Key”, then the
“Open” dialog box will appear

Step 2: On the “Open” dialog box, select a
specific .reg file to import

Warning:

1. The .reg file which should be saved by “Export
Registry Key”.

2. It will not save automatically after import a .reg file.
Export Registry Key Makes a back up of a registry sub-key

How to use:

Step 1: Select the “Export Registry Key”, then the
“Export Registry” box will appear

Step 2: Select a specific root key

Step 3: Input a specific path of sub-key

Step 4: Push the “OK” button, then the “Save As”
dialog box will appear prompting you to select a
location where you want to save this exported file

Warning:
The export operation will export all the sub-keys of
the specific key which you input.

Store All Registry Stores all registry setting to flash from .das file which
Setting is saved by “Dump All Registry Setting”.
How to use:
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The menu commands Use to

Step 1: Select the “Store All Registry Setting” , then
the “Open” dialog box will appear

Step 2: On the “Open” dialog box, select a

specific .das file to store

Warning:

1. The .das file which should be saved by “Dump All
Registry Setting”.

2. It will save automatically after store .das file.
Dump All Registry Dump all registries setting to .das file.

Settings

How to use:

Select the “Dump All Registry Setting”, then the
“Save As” dialog box will appear prompting you to
select a location where you want to save this
exported file.
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3.5.2. Property Tabs

The WIinPAC Utility includes the following property tabs, all property tabs will be
explained later.

WInPAC Utility, [2.0.2.1]

File Help Configuration

Welcome to use WINnPAC Utility
This tool will help you to set WinPAC - 8000,

Display Resolution IEIDD * 600 ha

WinPAC
“" r.:: Industrial (;c_rr_ltrul Products -
,_“b Data Acquisition System
Batteryl ; OK Task Bar Setting: [ ] Auto Hide Always On Top
Batteryz : OK

Ermpty Desktop
Change HTTP docurnent root directory Yywindows S wnwwpub o

|\wind0ws\www\wwwpub\ | l ] ’Settingl

Configure the synchronization with a time server

v’ System Setting

v' Ethernet Setting

v Network Setting

v System Information

v Auto Execution

v Multi-serial port wizard
v’ System Memory Setting
v Backplane Compatibility
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System Setting Tab

The System Setting tab provides functions to configure the task bar HTTP directory
path.

WinPAC Utility [2.0,2.1]

File Help Configuration

SYStBWSEttIﬁ9| Ethernet Satting I Network Setting ]5ystem Information ].&ut:n Execution l Multi-serial | 4

Welcome to use WinPAC Utility
This tocl will help you to set WinPAC - 2000,

Display Resolution IEHDIII * /00 e

WinPAC

\C¥ Industrial Control Products
“b""' Data Acquisition System

Batteryl : OK Task Bar Setting: [ ] Auta Hide Abways On Tap

Battery2 : OK Empty Deskiop
Change HTTP docurnent root directory ywindows'waeawwwpub to:

vindowes wrwenaeaewepub, | [ ] [SEtting]

Configure the synchronization with a time server [ Configure ]

The tab use to ‘ How to use

Adjust the size of the desktop Select a display resolution from the
Resolution list.

Lock or Auto-Hide the taskbar Auto-Hide:

Select the Auto Hide check box

Lock:

Select the Always On Top check box.
Check the status of the battery See the Batteryl and Battery? field that
displays the battery status.

Change the HTTP directory path Enter a new path in the Change HTTP
document root directory
\windows\www\wwwpub to field, and then
press the Setting button.
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Ethernet Setting Tab

The Ethernet Setting tab provides functions to configure either DHCP (Roaming) or
manually configured (Static) network settings and to monitor the MAC address.
Generally, DHCP is the default settings, but if you don’t have a DHCP server, you must
configure the network settings by using manual configuration.

WinPAC Utility [2.0.2.1]

File Help Configuration

System Setting [ Ethernet Setting || Network Setting | System Information | Auto Execution | Multi-serial L4

LANL LAz |

M&C Address 1; OU-0D-E0-30-01-6C

LAM 1 IP Address Setting:
(@) Use DHCF to get IP address

() Assign IP address

IP Address:  [10.1.0.61

Gateway |10.1.0.254

|
Mashk: |255.255.D.D |
|
|

DNS Server: |1I:|.D.III.3

The tab use to How to use

Configure the network Obtaining an IP address automatically from
settings DHCP:

Select the Use DHCP to get IP address option.
Manually assign an IP address:

Select the Assign IP address option.

Monitor the MAC address See the MAC Address 1 and MAC Address 2
fields that display the physical address of LAN1
and LAN2.
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Network Setting Tab

The Network Setting tab includes two tabs, FTP Setting and Users and Password.

The FTP settings tab

provides functions to enable/disable the FTP access,

enable/disable anonymous FTP access, and configure the FTP directory path.

WinPAC Utility [2.0.2.1] 9] =)
File Help Configuration

[S\,rstem Setting lEthemet Setting |NEtWDrk59ttlﬂ9| System Information I AUtn Execution I Multi—serialuL

FTF Setting | Users and Password ]

Upload

FTP (@) Enable () Disable
Allow Anonymous— (8) Enable { ) Disable
allows Anonymous (3) Enable { ) Disable

Change FTF default download directory \Temp to;

|\Te mp’,

L]

The tab use to ‘ How to use

anonymous FTP
access

Enable or disable | Enable:
the FTP access Select the Enable check box in the FTP field.
Disable:
Select the Disable check box in the FTP field.
Enable or disable | Enable:

Select the Enable check box in the Allow Anonymous field.
Disable:
Select the Disable check box in the Allow Anonymous field.

Enable or disable
anonymous FTP
upload

Enable:
Select the Enable check box in the Allow Anonymous
Upload field.
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The tab use to ‘ How to use

Disable:
Select the Disable check box in the Allow Anonymous
Upload field.
Change the FTP Enter a new path in the Change FTP default download
directory path directory field, and then press the Setting button.
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The FTP settings tab provides functions to add, delete, and manage the user account
for FTP, telnet and Web server access.

WinPAC Utility [2.0.2.1] 9] =)
File Help Configuration

[System Satting ]Ethemet Satting | Metwork Setting |53t5tem Infor mation l.&uh:n Exerution ]Multi-serial | L4

FTF Setting || Users and Password I

Uzer name Password
I I |[ 4dd | Dekt

Lser name | Password | Mote:

arna o The accounts is used o login

the servers search as Telnet,
FTP, WebServer et on WinPAC,

Setting

The tab use to ‘ How to use

Add a user Fill in the User name and Password field of your user account,
account press the Add button, and then press the Setting button

Delete a user Choose a user name from the user account list, the user
account account that you select will display in the User name and
Password filed, press the Delete button, and then press the
Setting button

* The maximum number of the user accounts is 5.

* The maximum of the string length of the user name and password fields must
be less than 20 charachters.

For more information on how to use a user account to login WinPAC, please refer to
“E.1. How to set up a telnet and FTP account to login WinPAC”
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System Information Tab

The System Information tab provides functions to monitor necessary system information
of the WIinPAC. The system information is the most important note of version control for
upgrading system.

WinPAC Utility [2:0.2.1]

File Help Configuration

I System Setting l Ethernet Setting ] Metwork Setting | System Information | Auto Execution I Multi-serial | 4

Sloto: [ | Modie Type: |we-844x (9EMB)
Siat 1 I:l Flash TypeiSystem_disk): |

Flash Type(0S): |

Slot 2:
I:l E4-hit Serial Number

|Dl-Cf-'«-E|9-EIl—12—DD-DD-DI5
03 Yersion: |1.4.1.2 , 2009/08/05 10:16:15

Eboaot Yersion: |1.D.5.El , 2009,/01/22 15:59:42
CPU Wersion: |1.D.EI.D

WinPacsDK Version: |2) 0,00

WinPachet Wersion: |1.2.D.6

MET Frarmework Yersion: |2.D.?‘D45.DD

SOL CE Yersion: |3.5.5386.D

|
|
|
|
|
|
Backplane Yersion: |1.D.2.D |
|
|
|
|
|
|

Last Save Date: |M0nday, December 06, 2010
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Auto Execution Tab

The Auto Execute tab provides functions to configure programs running at WinPAC
startup, it allows users to configure ten execute files at most.

The allowed file types are .exe and .bat, and they are executed in
order of program 1, program 2, etc.

WinPAG Utility, [2.0.2.11]

File Help Configuration

Program 1: |\System_Disk‘\Tcu:uIsWCEF‘\v_rethe.exe | ’ Browse ]
I! Program 2 | | ’ Browse ]
—=] Prograrn 3: | | ’ Browse ]
Program 4 | | ’ Browse ]
Frogram 3. ‘ ‘ ’ Browse ]
S:Drg?as:nincan b Program &: | | ’ Browss ]
specified to Program 7: | || Browse |
execLUte
aumatically at  Program &t | | ’ Browse ]
system startup.
Frogram 9: | | ’ Browse ]
Prograr 1EI:| | ’ Browse ]

The tab use to How to use

Configure programs Press the Browse button to select the execute file
running at startup which you want, and then press the Setting button.
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Multi-Serial Port Wizard Tab

The Multi-serial port provides functions for installation of the
RS-232/RS-422/RS-485 communication module driver.

The table below shows the expansion
’ RS-232/RS-422/RS-485 communication modules
that are compatible with the WinPAC.

RS-232 RS-422/RS-485 Isolation Connector

[-8112iIW 2 - 2500 Vrms DB-9 x 2

[-8114W 4 - - DB-37 x 1

[-8114iW 4 - 2500 Vrms DB-37 x 1

[-8142iW - 2 2500 Vrms Terminator block x 1
[-8144iW - 4 2500 Vrms Terminator block x 1

The WIinPAC can be expanded to support up to 16 COM ports.

For more detailed information about these support modules, please refer to
http://www.icpdas.com/products/Remote |0/i-8ke/selection_rs232_i8k.htm

WinPACG Utility [2.0.2.1]

File Help Configuration

=1 Shot2
Slot 0: o Msal @ Driver enabled
o Msa2
Slat 1; M3 0 oz
B veas Driver disabled

Slot 2:

UL

Slot 3 | s144

Install driver (apply to I-6112/8114/5142/5144 series modules )

LISE MSAMSEx
Stepl: | Set [ JuUsE comx
Step2:  Go to "File" --="Save and Reboot" to enable driver

Slot scan (Refresh)
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System Memory Setting Tab

The System Memory Setting tab provides functions to adjust and monitor the unused
RAM.

WInPAG Utility, [2.0.2.1]

File Help Configuration

IAub:u Execution I Multi-zerial part wizard | System Mamory Setting || Backplane Compatibility ] 1 I

Maove slider 1o the left for more memory to run
progrars. Move slider to the right for more storage
room. Only unused RAM can be adjusted.

Storage “1
Mermory v

Frogram
Il oy

dllocated: 48456KE allocated:  43456KE

In Use: 454KE In Use: 14088KB

The tab use to How to use

Adjust display Move the slider left to release more memory running

programs or move the slider right to release more
storage room, and then press the Setting button
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Backplane Compatibility Tab

The Backplane Compatibility tab provides functions to keep old programs running on
WinPAC without any modification. the unused RAM.

WiInPAC Utility, [2.0.2.1]

File Help Configuration
I ALt Execution I Multi-serial port wizard I System Memory Setting |: Backplane Compatibility : 1 I

This setting may let WinPac support old programs
which run on the following device.

(@) WinPaC 8000
{ ) COM Port Backward Compatible for WinCon

Support Devices:

VW'-Bx3x Series: W-Bxdx Series:

\W-B031 f 8035-G \W-B041 /8047 / 8045-G

\W-8331 f8339-G \W-8341 /8347 [ 8349-G

\W-8731 f8738-G \W-B741 /8747 f8749-G
Setting

The tab use to How to use

Configure programs Select the “COM Port Backward Compatible for
running at WinCON-8000 WinCon” and then press Setting button
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4. Your First WinPAC Program

This chapter describes the components of the WinPAC SDK, and provides step by step
tutorial for developer that will teach you how to create your first WinPAC program.

Before writing your first program, ensure that you have the necessary development tools
and the corresponding WinPAC SDKs are installed on your system.

4.1. Preparing the Development Tools

There are several programming tools available for application developers targeting
Windows CE-based WInPAC. One of the following tools must be installed on the Host
PC.

v" Microsoft eMbedded Visual C++
v Visual Basic.net
v Visual C#
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4.2. Installing WinPAC Platform SDKs

The WInPAC Platform SDK is a Software Development Kit (SDK) that contains C header
files, C libraries and documents.

Below is a step by step procedure for installing the WinPAC Platform SDKs.

Step 1: Insert the CD into your CD-ROM drive

Step 2: Execute the “PAC270_SDK_YYYYMMDD.msi” which is located in

>» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\SDK\

>» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\SDK\

The installation program for the latest version of the WinPAC Platform SDKs can be
obtained from:

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/sdk/

File name: pac270_sdk _yyyymmdd.msi
yyyymmdd: platform sdk released date

Tips & Warnings

.ﬁ The released date of the installation program SDK installation
package that provides the PACSDK library must be later than or

equal to 2012/10/15, such as PAC270_SDK 20121015.msi

Step 3: Follow the prompts until the installation is complete
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4.3. Understanding the WinPAC SDK

The WIinPAC SDK includes several application programming interfaces (APIs) that
allows you perform various supporting tasks when developing WinPAC.

» Requirements

The WIinPAC SDK only supports .NET Compact Framework 2.0 or above.

» Installation Path

After installing the WinPAC SDKs, a number of functions can be installed on the Host
PC, and this installation puts the header files, libraries into the following public places so
they are easily changed by update the WinPAC SDKs.

Header files:
C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Iinclude\ARMV4I\

Libraries:
C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\
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4.3.1. WinPAC SDK Overview

I ' — System Information — Watchdog

| — Backplane Access - UART

— Interrupt — Registry

L Memory Access — Micro SD
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e SystemInformation Functions
Provides reference information for the system status.

e Backplane Access API
Provides reference information for the backplane access APIs, including backplane
information.

® Interrupt API
Provides reference information for the Interrupt APIs

® Memory Access API
Provides reference information for the memory R/W APIs, including EEPROM and
SRAM.

e WWatchdog Functions
Provides reference information for the watchdog APIs, including hardware watchdog
and OS watchdog.

e Uart API
Provides reference information for the Uart APIs.

® Registry API
Provides reference information for the registry.

e MicroSD Management API
Provides reference information for the MicroSD Manager.

e PAC_IO API
Provides reference information for 10 APIs, including local and remote.
In additions, no matter 8K or 87K modules use the same API.

e Error Handling API
Provides reference information for error handling.
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4.3.2. WinPAC SDK Reference

For full usage information regarding the description, prototype and the arguments of the
functions, please refer to the “PAC Standard APl Manual” located at:

» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\Document\SDK_Document\

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/document/sdk document/

» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\Document\SDK_Document\

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/document/sdk document/

ﬁ WinPAC Standard API mamual ¥1.9.1 pdf - Adobe Acrobat Fro
HERE REED BRE xXHED $F0 Q) TH(T SR Sl Jdily

Gleme Blatte &)t re- R (" "k
OB a4 € %0 =1 & Table of Contents
[| Preface ~
E| Cvervies of the WinPacSDkK
= [| 1. Systern Information Functions 1
[| Table of Contents
E Freface |ﬂ 1.1, pac_GetoduleMame
E| Cwerview of the WinPacSDK 1.2 ac cetRotaryID
E||E| 1. System Information Functions m - I:' - I:III
[| 1.1. pac_GettoduleMame m 1.3, F'a':_Er'Iah'ELED
g 12, [FEE(EEiREETID |ﬂ 1.4, pac_GetSerialMumber
1.3, pac_EnableLED .
[| 1.4. pac_GetSerialMumber m 1.5 [:IaE_GEtCPU"v"EI’SIDﬂ
El 1.5, pac_GetCPUVersion m 1.6, paE_GetOS'\,-'ErSiDn
[| 1.6, pac_zetOSYersion i
B 17, poc_ catbootversian |ﬂ 1.7, pac_GetEbootversion
] 1. pac_GetsDkversion K 18 pac_GetSOkMersion
[| 1.9. pac_GetMacaddress
E] 1.10. pac_changesiot |ﬂ 1.9, pac_Getacaddress
[ 1.11. pac_Reboat & 1.10. pac_ChangeSlot
E 112
pac_BackwardCompatible E 1.1L paE—REbDDt
|[| 1,13, pac_GetComMapping m 1.12,
B 2. Backplane access APT pac_BackwardCompatible
E 3. mterrupt aP1 - _
= 4, Memory ACCass AP m 1.13. paE—GEtCDmM‘applng
Bl 5. watchdog Functions E] 2. packplane Access AP
El & MicrosD Management AP |[|
F] 7. Registry 4F1 3. Interrupt AP1
K] 8. UART 41 K 4. Memory ACCess AP
PAC‘IOPI. o ®] s, watchdog Functions -

%] &, MicroSD Management AFT
& 7. Registry AP

E] 8. UART API

K] o, pac_10 AP
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ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/document/sdk_document/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/document/sdk_document/

4.4. Your First Program in C#

Here we will explain how to create a C# program running on WinPAC. We assume that
you use Visual Studio 2005/2008.

Depending on the version of

To create a demo program with C# development tool includes the following main steps:

1. Create a new project

2. Add project reference for an application
3. Design and Build an application program
4. Execute the application on the WinPAC

All main steps will be described in the following subsection.

4.4.1. Create a new project

Step 1: Start the Visual Studio 2005

Step 2: On the “File” menu, select the “New” command, and then click the
“Project” command

Edit Wiew Froject Buwild Debuzg Dats  Tools  Tegt  Window Help
Hew P | 20 Eroject... Ctel+Shift+H
Open @ | Web Site.. Shift ATt
Add b | ) Eie.. Ctol
Close Project From Existing Code...

@l Clos Solution

A

@ Bave AL Crl+Shift+s
Export Template. ..

I}

<4
Eecent Files 3
Recent Projects 2
Ezuit
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Step 3: In the “New Project” dialog box do the following in this order

New Project

Froject trpes: Templates: |§|
= Visual C# Yisnal i0 ingtalled templates

TWindows )
= Bmart Device < LﬁDevice Application @Cl&ﬁ Library
i Pocket PC 2003 M p : % Comsole Application
' EEmpty Project
My Templates
- Other Project Types i Search Online Templates. ..

L project for creating a 10 t Framework 2.0 forms application for Windows CE 5.0 and later |
- =
Waume: | systernintol ) |
<

Location: Z: OWE ool#C# w | Browss...
Solution: | Create new Solution b | Create divectory for solution
Bolution Nagme: | systerninto |

[ ok || Cancel

Step 4: Click OK to start creating a “systeminfo” project
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4.4.2. Add project reference for an application

Step 1: On the “Solution Explorer” window, right-click the “Reference” and
then click the “Add Reference...” command

Solution Explorer - Solution.._[¥]

= | iy
= |£| - . Step 2: In the “Add Reference” dialog box,
o] Solution ‘systemina’ (1 project) select the “Browse” tab, and then specify

= |5 systeminfo
=d| Properties the directory of the “PACNET.dII” file in the
=i “File name” field
=] Forml cx Add Beference .

] Prograrm.cs Add Web Reference...

@Cl&ﬁ Wieye |,:.3 Solution Explorer

The “PACNET.dII” file can be obtained from:

>» For WP-8x3x series:
CD:\Napdos\wp-8x3x_ce50\SDK\WinPacNet\
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/sdk/winpacnet/

>» For WP-8x3x series:
CD:\Napdos\wp-8x4x_ce50\SDK\WinPacNet\
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/sdk/winpacnet/

Add Eeference

NET | Piojects | Browse |Recent|

HSHED: | Exomple v 02 o

[ bin
) My Project
[Z)0bi

PACNET

E=ERW: PACNETIL v/
T EEAREN(T): | Component Files (% d11* b;* olb ;¥ e exe)
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4.4.3. Design and Build an application program

Step 1: Buton  Add a “button” object in the “From1” dialog box

Step 2: Right-click the “button” object and click the “Properties” command

Forml .cs [De:ign]*i Start Page _7 Object Browser | w X
A

Form1

[Z] View Code
<4 Bring to Front
%

Send to Back

@ Lock Controls
Select Forml'

& Cu

Za Copy

= mainMenul -
X Delete

5 Properties




Step 3: On the “Properties” window, type “Check the OS version” in the
“Text” edit box

Properties

buttonl S-vstemn. Windows Forms Button

RightToleft

Check the OF version «
Texthlign MiddleCenter
TextlmageRelaton  Owerlay

TT 1r m

Text
The text azsociated with the contral.

@Cl&ﬁ Wiew |L:-3 molution Explorer ﬂPmperﬁes |

Step 4: In the “Form1” dialog box, double-click the button” object to open
the editor window

Double-click
the button
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Step 5: Insert the “using PACNET;” into the header area after “using
System.Windows.Forms;”

Clusing Svstem;

uzing eystem.Collections  Generic;
nEing wvsten . Componenthodel ;
uzing system Data;

nEing mvstem Drawing;

uzing system. Text

nzing wvstem Windows Forms;
UE1ng PACHET ;|

E namespace Example
| I

Tips & Warnings

The “PACNET” of “unsing PACNET” is case- sensitive
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Step 6: Insert the following code in the Editor Window

MessageBox.Show(PACNET. Sys .GetOSVersion());
MessageBox.Show(Sys.GetOSVersion());

Fnamespace systeminfo
{

public partial class Forml - Form

= { public Forml()
i InitializeComponentd];
=] private woid buttonl_Click{object sender, Eventirzs el
{ Wezzazeboxr Show{ PACKET Hvs GetliVersion( ));
HessageBDx.Shnw{Sys.GetDSFersiDn{)};
-,
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4.4.4. Execute the application on the WinPAC

Step 1: On the “Build” menu, click the “Build Solution” command

Fil: Edit ¥iew Project [Evild | Debug Data Formst Tools  Tet Window Help
Build Solotion  Cte+Shift+ B
Rebuild Zolotion
Deployy Bolution
Clean Solntiom

5 Build systeminfo

Febuild systeminfo
Deploy systeminfa
Clean systerninfo
Batch Build ..
Configuration Manager...

Step 2: Open the web browser and type the IP address to connect the FTP
server of WinPAC

Step 3: Upload the “systeminfo.exe” application and the corresponding
“PACNET.dII” file to the WinPAC via the WinPAC FTP server
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Tips & Warnings

A For applications programming in C# and VB.net with .net compact
framework, when executing these application on the WinPAC
controller, the corresponding “PACNET.dII” file must be in the
same directory as the .exe file

Flle Edit Yiew GO

R EEmEEEEE s mEEsEE s

systeminio:  PACHET

Step 4: On the WIinPAC, execute the uploaded file

| Check the OS5 version |
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4.5. Your First Program in VB.net

To create a demo program with C# development tool includes the following main steps:

1. Create a new project

2. Add project reference for an application
3. Design and Build an application program
4. Execute the application on the WinPAC

All main steps will be described in the following subsection.

4.5.1. Create a new project

Step 1: Start the Visual Studio 2005

Step 2: On the “File” menu, select the “New” command, and then click the
“Project” command

Edit View  Froject mld  Debuz Date  Tool: Text Window  Help

New » Project... C e+ Shaft+ I
Oipen g Web Bite. . Shift+ A1+
4dd > Fils.. Ctl

Close Froject From Exdsting Code...

o & |

51 Close Solution

-

@ Save Al Cl+Ehift+3
Export Template...

=

i

Eecent Files 2
Eecent Projects 4

Exit
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Step 3: In the “New Project” dialog box do the following in this order

New Project

Project types: Templates:
= Visual C# ~ ¥izual Studio installed templates
o Windowes i
- Bmart Device @' Lﬁ Dievice Application @Cl&ﬁ Library
Datahas:e_ N i %Cumle Application
- tarter Eits =:| Epnpty Project
= Other Langvages aE
=) Vizual Bagic
o Windows My Templates
[=)- Bmart Device )
© . Pocket P 2003 i Search Online Templates...
- Windows CE 5.0 )
. Starter Kits
- Visual J# B
[+ Visval C++ %
& project for creati weark 20 formz application for Windows CE 5.0 and later |
.
Hame: |s3.rstem.1'n.f|:| j |
E— L
Location: |C:".Windu:1w3 CE ToolAWEB net w | E_Bmwse... i
Solution; |Create new Solution b | Create directory for solution
Solution Wagmne: |sg.rstemjn.fo |
OK || Cancel

Step 4: Click OK to start creating a “systeminfo” project

WinPAC 8000 User Manual, version 2.0.7.  Last Revised: October 2012  Page: 98

Copyright © 2009 ICP DAS Co., Ltd. All Rights Reserved. = E-mail: service@icpdas.com




4.5.2. Add project reference for an application

Step 1: On the “Class View” window, right-click the “Reference” and then
click the “Add Reference...” command

Class Yiew

Step 2: In the “Add Reference” dialog

T : T — box, select the “Browse” tab, and then
14 Web Reference. specify the directory of the
Sunﬂl;hﬂheﬁmuy “PACNET.dII” file in the “File name”
I%Cl‘mv'" S50l gon By Objest Typs field
Aot By Object Lecess
Grroup By Object Twpe

The “PACNET.dII” file can be obtained from:

» For WP-8x3x series:
CD:\Napdos\wp-8x3x_ce50\SDK\WinPacNet\
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/sdk/winpacnet/

>» For WP-8x3x series:
CD:\Napdos\wp-8x4x_ce50\SDK\WinPacNet\
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/sdk/winpacnet/

Add Eeference

NET || Projects Browse |Recent |

HBUED: | () Example CIREN: A=dER

(3 bin
| b Project
|yobi

PACNET.All

ERARW: pPACNETIL v
T FEARR(T): |Cl:lmpl:ln|3]1t Files (* d1l;* tlb:* olb;* oo exe) w |
[ 0K || Congel |
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4.5.3. Design and Build an application program

Step 1: Buton  Add a “button” object in the “From1” dialog box

Step 2: Right-click the “button” object and click the “Properties” command

Forml .cs [De:ign]*i Start Page _7 Object Browser | w X
A

Form1

[Z] View Code
<4 Bring to Front
%

Send to Back

@ Lock Controls
Select Forml'

& Cu

Za Copy

= mainMenul -
X Delete

5 Properties




Step 3: On the “Properties” window, type “Check the OS version” in the
“Text” edit box

Properties

buttonl S-vstemn. Windows Forms Button

RightToleft

Check the OF version «
Texthlign MiddleCenter
TextlmageRelaton  Owerlay

TT 1r m

Text
The text azsociated with the contral.

@Cl&ﬁ Wiew |L:-3 molution Explorer ﬂPmperﬁes |

Step 4: In the “Form1” dialog box, double-click the button” object to open
the editor window

Double-click
the button
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Step 5: Insert the following code in the Editor Window

1. Imports PACNET
2. MessageBox.Show(PACNET.Sys.GetOSVersion())
3. MessageBox.Show(Sys.GetOSVersion())

Imports PACMET

pPublic Class Forml

= Frivate 3ub Buttonl _Click{BvVal sender &= 3wstem.Ohject, BwVa

MezzageBox  Show{PACNET Swve Get0iVWersion( )

WezsageBox . Show(Bvs Get0iVersion i) e
End 3ub

“End Class

Tips & Warnings

The “PACNET” of “Imports PACNET” is case- sensitive
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4.5.4. Execute the application on the WinPAC

Step 1: On the “Build” menu, click the “Build Solution” command-

Fil: Edit ¥iew Project [Evild | Debug Data Formst Tools  Tet Window Help
Build Solotion  Cte+Shift+ B
Rebuild Zolotion
Deployy Bolution
Clean Solntiom

5 Build systeminfo

Febuild systeminfo
Deploy systeminfa
Clean systerninfo
Batch Build ..
Configuration Manager...

Step 2: Open the web browser and type the IP address to connect the FTP
server of WinPAC

Step 3: Upload the “systeminfo.exe” application and the corresponding
“PACNET.dII” file to the WinPAC via the WinPAC FTP server

WinPAC User 8000 Manual, version 2.0.7.  Last Revised: October 2012  Page: 103

Copyright © 2009 ICP DAS Co., Ltd. All Rights Reserved. = E-mail: service@icpdas.com



Tips & Warnings

A For applications programming in C# and VB.net with .net
framework, when executing these application on the WinPAC
controller, the corresponding “PACNET.dII” file must be in the
same directory as the .exe file

Flle Edit Yiew GO

R EEmEEEE R mEEEEE mEEEEE

systeminfo;  PACHET

Step 4: On the WinPAC, execute the uploaded file

| Check the OS version |

1.4.1,2
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4.6. Your First Program in eMbedded Visual C++

To create a demo program with eMbedded Visual C++ development tool includes the
following main steps:

1. Create a new Forms-Based project

2. Configure compiler options

3. Design and Build an application program
4. Execute the application on the WinPAC

All main steps will be described in the following subsection.

4.6.1. Create a new Forms-Based project

Step 1: Start the Microsoft Embedded Visual C++

Step 2: From the “File” menu, click the “New” command

|File Edit View Insert Project Buid Tools Window Help

W New ... Ctrl+N

& Open.. CtlO

Open Worksp Files Projects | Workspaces
vave Worl Project name:
. WCE ATL COM AppWizard |
|%] WCE Dynamic-Link Library
#i= WCE MFC ActiveX Control\Wizard A
S & WCE MFC AppWizard [dIl] L"lgat“’"'
BAWCE MFC AppWizard [exe) CAWINDOWS CE TOOLS\CHY .|
%] WCE Static Library
1}7-’“ DEVE + Create new workspace
i
r
Recent Files CPUs:
Recent Works ¥Win32 [WCE ARMV4) ~
- ¥M\Win32 [WCE ARMVAI)
: CWin32 [WCE ARMYAT) B
Exit Win32 (WCE MIPS16)
#MWin32 [WCE MIPSI)
#MWin32 [WCE MIPSIL_FP) v
‘ Cancel |
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Step 3: In the “New” dialog, select the “Projects” tab and do the following in
this order

Files Projects | Workspaces

=|WCE Application }m;/m\ wawre!
o] WCE ATL COM AppWizard |systeminiu

UWCE Dynamic-Link Library

3 I, WCE MFC ActiveX ControlWizard

FC AppWizard [d
&!WCE MFC Aplezard [exe]

Location:
|C:\WINDOWS CE TOOLS\C++\sy J

+ Create new workspace
" Add to current workspace
-

| =

CPUs:

WWin32 [WCE ARMY4]
MWin32 [WCE ARMVAI]
[Win32 [WCE ARMYAT)
[(Win32 [WCE MIPS16)
MWin32 [WCE MIPSI)
MWin32 [WCE MIPSIL_FP)

OK | Cancel

[

| £

Tips & Warnings

The selected CPU type must have “Win32 [WCE ARMVA4I]”

“JWin32 (WCE ARMV4 ~
®Win32 (WCE ARMV4I)

CJWin32 [WCE ARMVAT)

CJWin32 (WCE MIPS16)

CIWin32 (WCE MIPSII)

CIWin32 (WCE MIPSII_FP) v

Step 4: Click the “OK” button to start the wizard
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Step 5: On the first page of the wizard, select “Dialog based” option and
then click the “Next” button to the next step

WCE MFC AppWizard {(exe) - Step 1 of 4

‘What type of application would you like to
create?

" Single document

What language would wvou like your resources

in?
=l

< Back | Next > | Finish Cancel

Step 6: On the next page of the wizard, leave all the options as they are, and
then click the “Next” button to the next step

WCE MEC AppWizard (exe) - Step Z of 4 3

Application

[~ Windows Help
[ ActiveX Controls

Please enter a title for your dialog:
SDKinfo

< Back | Next > | Finish ‘ Cancel
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Step 7: On the next page of the wizard, leave all the options as they are, and
then click the “Next” button to the next step

WCE MFC AppWizard {exe) - Step 7 of 4

B Froject.cpp
SETODO:
! " No, thank you

SATODO:

How would you like to use the MFC library?

* As a shared DLL

" As a statically linked library

< Back | Mext > | Einish Cancel

Step 8: On the next page of the wizard, leave all the options as they are, and
then click the “Finish” button to complete the wizard

WCE MFC AppWizard {exe) - Step 4 of 4

AppWizard creates the following classes for

wvou:

CSDKinfoApp

CSDKinfoDIg

Class name: Header file:

|CSDKinfoApp |

Base class: Implementation file:
< Back ‘ ‘ FEinish | Cancel
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Step 9: The final summary appears, click the “OK” button to exit the wizard

New Project Information

WCE MFC AppWizard [exe] will create a new skeleton project with the
following specifications:

Application type of SDKinfo:
Dialog-Based Application targeting:
Win32 (WCE ARMYAI)
Win32 (WCE MIPSII)
Win32 (WCE MIPSIL_FF)]
Win32 (WCE MIPSIV]
Win32 (WCE MIPSIV_FF]
Win32 (WCE SHA4]
Win32 PMWCE emulator)
Win32 (WCE x86)

Classes to be created:
Application: CSDKinfoApp in SDKinfo.h and SDKinfo.cpp
Dialog: CSDKinfoDlg in SDKinfoDlg.h and SDKinfoDlg.cpp
Yiew:. CChildV¥iew in ChildView.h and Child¥iew.cpp

Features:
+ Uses shared DLL implementation
+ Localizable text in:

#2L [ZE[E]
Project Directory:
CADOCUMENTS AND SETTINGSYWINDOWS CE TOOLS\EVCASDKinfo

..............................................

0K Cancel
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4.6.2. Configure compiler options

On the WCE configuration toolbar, select the “Win32 [WCE ARMV4]
Release”

. SDEinfo - Microsoft eMbedded Yisual C++

H File Edit View Insert Projest Build Tools Window Help
Bedd s e EEE | =]
CSDKinfoApp || A class members] x|| & CSDKinfoApp R ‘

- Wini2 (WCE ARMYAI Release
#- & SDKinfo classes in32 (WCE emulator] Debug
in32 (WCE emulator] Release
in32 (WCE MIPSII Debug

in32 (WCE MIP5II) Release
in32 (WCE MIPSII_FP) Debug
in32 (WCE MIPSII_FP] Release
in32 (WCE MIPSIV] Debug

-'r: Cl... I Re... | Fil... |

Ready
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4.6.3. Specify the path for project reference

Step 1: Click the “Options...” command from the “Tools” menu

File Edit Yiew Insert Project Build | Tools Wmdow Help

Bomce Browssr. . Alt4F13

A Exrror Lookup

A% Remote Call Profiler (WCESOD)

A% Remote File Viewer (WCESO0)

A% Remote Heap Walker (WCESO0)

A Eemote Kemel Tracker (WCESODY

A Eemote Performance Maondtor (MCESOO
A% Remote Process Viewer (WCESOO)

% Bemnte Registry Editor (WCES0O)

A% Remote Spoe+ (IWCESDD)

A Eemote Systemn Information (WCESOD)
A4 Remote Zoomin (WCESDD)

melect Femote Tools
Cuzstomize. ..

Cptons...

: : Macro...
Eecord Ouick Macio Chl+Ehift+F
Flayr Qiick Macro Crl+Ehift+ P

Configure Platfoom Manager. ..
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Step 2: In the “Option” dialog, select the “Directories” tab and do the
following in this order to specify the header file include path

The specified include path of the header file is default located at:

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Include\ARMV4I\

Download | B rkspacﬂ | Macros | Format | [«

Platform: CPUs: 5
|PAC270 — STANI ~ ||Win32 [WCE ARMY4I) @l/Include files -
Directories: F R O R 2

CAProgram Files\Windows CE ToolsYwceS0MSTANDARDSDE. 500\Includels
CAProgram Files\Windows CE ToolsbweeS0MSTANDARDSDE. 500vmfckinciu

Click this button
to specify the

header file
include path
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Step 3: In the “Option” dialog, select the “Directories” tab and do the
following in this order to specify the library file path

The specified include path of the library file is default located at:

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\

Download | B rkspace | Macros | Format | [«

Platform: CPUs: 5
PAC270 — STANI ¥ ||Win32 [(WCE ARMV4I) gu@.w files ~
Directories: E S I

CAProgram Files\Windows CE ToolsbwoceS0WSTANDARDSDE 500ibVARMY.
CAProgram Files\Windows CE Toolsbwceb0MWSTANDARDSDE. 500mfchlib\AF

Click this button
to specify the

library file path
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Step 4: Click the “Settings...” command from the “Project” menu

File Edit ¥Yiew Insert |Project Buwild Tools Window Help

set Active Project »
Add To Project »

LB

Export Makefile. .

Lnzert Project tnto Workspace. .

Step 5: In the “Project Settings” dialog box do the following in this order

Project Setings

Settings For: General | Debug | Cur-::es | M EE

Win32 [WCE ARMYA4() Helease -
| Category: |GE“E’3| ]'
+ B3

Qutput file name:
|AFIM‘."dIFIEIJ'systerninfﬂ.Exe

les:

|PACSDK.Iih )

[T Generate debugq Info [~ Ignore all default llbrarles

[ Generate mapfile

Project Options:

inologo fhase k00010000 fstack:0=1 0000, 0x1000 ~
Jentry wWinMainCRTStartup" fincrementalino
Ipdb:"ARMYAIRel}systeminfo.pdb"

OK | Cance|
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4.6.4. Design and Build an application program

Step 1: On the “Workspace” window, select the “ResourceView” tab and
expand the “dialog” folder, and then double-click the
“IDD_DEMO_DIALOG” to open the dialog box

| x|
=<3 SDKinfo resources
=<3 Dialog
B DD SDKINFO DIALOG [English [U.5.]]
#-(1 lcon

+- (] Yersion

B & ClassView @Flf:auurcﬂ\.l'iﬂw FileView

Step 2: Add the “button” object in the “systeminfo” dialog box

& SDKinfo.rc - IDD_SDKINFO_DIALOG [German (Germany)] (Dial.. [ |(B01|[3]

[F N OO OO OO =)
i B SDKinfo B Control: ®
I T I n B 4 abl [ O

- ::: B x @ EH E
-f |t me-EHE O
Button1 | W B E e

»

- : ZU ERLED.: Dialogfeld-Steuerelem.
: hier
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Step 3: In the “systeminfo” dialog box, right-click the button object and then
click the “Properties” command

& SDKinfo.rc - IDD_SDKINFO_DIALOG [German (Germany)] (Dial... [ |[B1][X]

W 1 RRRRECRR TN u
[ ] Buttoni t
- e R £ Cut
Copy

- 71l ERLED.: Dialogfeld-Steusn
hier

Insert ActiveX Control...

Size to Content

T Check Muemonics

X ClasWizard...
Events. ..
Properties

Step 4: Type the “Check the OS version” in the “Caption” edit box and then
click @] the “close” button

Push Button Properties [
4 % General | Styles | Extended Styles |

ID: |IDC_BUTTONT | Caption: |Check the 0S version|
v Yisible | Group
[ Disabled v Tab stop
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Step 5: In the “systeminfo” dialog box, double-Click the button object

B zy:teminfo |E|

.................................................................................................

Double-click

EI_I ERLED.: Dialogfeld-Steuereler e bution

Step 6: Type the “OnBtnCheckOS” in the “Member function name” edit box
and then click the “OK” button

Add Member Funchion

Member function name: 0K

OnBtnCheck0§|

Cancel

Message: BN _CLICKED
Object ID: IDC_BUTTONI1
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Step 7: Insert the following code into the Editor Window

char OS[32];

TCHAR buf{32];
pac_GetOSVersion(OS);
pac_AnsiToWideString(OS, buf);
MessageBox(buf,0,MB_OK);

FELUr il Inurc 4

void CSysteminfoDlg::0nBtnCheck0S()

{
£ TODO: Add your control notification
char 03[32];
TCHAR buf[32];
pac_GetD3Uersion(0S);
pac_AnsiToWideString(0S, buf);
MessageBox{buf ,8,MB_OK);

Step 8: Insert the “#include “PACSDK.h”” into the header area

fHinclude “stdafx.h"”
Hinclude “systeminFu.h“
Hinclude “SyﬁteminFublg.h"

Hinclude "PACSDEK _.h"

HifFdef _DEBLG

fidefine new DEBUG_HEW

fundef THIS_FILE

static char THIS_FILE[] = _ FILE
Hendif

WinPAC 8000 User Manual, version 2.0.7.  Last Revised: October 2012  Page: 118

Copyright © 2009 ICP DAS Co., Ltd. All Rights Reserved. = E-mail: service@icpdas.com



4.6.5. Execute the application program on WinPAC

Step 1: On the “Build” menu, click the “Build systeminfo.exe” command

File Edit Yiew Insert Project Buidd Tool: Window Help

#2 Compile SDEinfoDlgcpp  CtleF7
Build SDEinfo exe

Sl ==

Eebuild &1
Batch Budld...
Clean

start Debug 3
Tpdate Bemote Output Fileiz)

Execute SDEinfo exe Chl+FS

met &otive Configuration. ..
Configurations. ..
aet Active Platform. ..

Step 2: Open the web browser and type the IP address to connect the FTP
server of WinPAC

Step 3: Upload the “systeminfo.exe” application to the WinPAC via the
WIinPAC FTP server

File Edit View Go

Step 4: On the WinPAC, execute the
& ¥ /] [~ uploaded file

systeminfo ™ |

01040102

Check the OS yersion

ZU ERLED.: Dialogfeld-Steusrelemn. hisr
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5. APIs and Demo References

This chapter introduces demo programs that have been designed for the WinPAC. You
can examine the demo source code, which includes numerous comments, to familiarize
yourself with the WinPAC API. This will allow developing your own applications quickly by
modifying these demo programs. The following details the contents of the WinPAC demo
programs.
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5.1. Demo programs with C#

The following C# demos have been designed to demonstrate the various features
of the WinPAC.

5.1.1. C# Demo programs for WinPAC Standard API

The table below describes the WinPAC demos that have been designed to
demonstrate the standard operation features of the WinPAC.

| System Information — Watchdog

| Backplane Access — UART

Interrupt — Registry
Memory Access — Micro SD
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WinPAC Standard API:

Explanation

Retrieves information about the OS

system systeminfo version, CPU version, SDK version,
etc.
_ Retrieves information about the DIP
backplane backplaneinfo _
switch, backplane ID and slot count.
Shows how to read/write date values
memory
from/to EEPROM
memoryaccess

Shows how to read or write to the

battery _backup_sram
V= S battery backup
watchdog watchdog Displays how the watchdog operate

Shows how to enables/disables
Micro SD

Shows how to read/write date values
from/to registry

microsd microsd_management

reqgistry registry

Shows how to read the name of

uart dia
g local I/O modules via UART

For C# application, these demo programs can be obtained from:

» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\Demo\WinPAC\DotNET\C#.NET\Standard\
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/demo/winpac/dotnet/
c%23.net/standard/

>» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\DotNET\C#.NET\Standard\
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/
c%23.net/standard/
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ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/demo/winpac/dotnet/c%23.net/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/demo/winpac/dotnet/c%23.net/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/standard/

5.1.2. C# Demo programs for PAC IO API

The table below describes the WinPAC demos that have been designed to
demonstrate the expansion I/0O module features of the WinPAC.

Local I/O

PAC 10 API:

Shows how to retrieve the module names and types

find_io . : :
- which plugged in the WinPAC.
_ Shows how to read the DI values of DI module.
Local 8k _di ) . .
This demo program is used by 8K series DI modules.
8k do Shows how to write the DO values to DO module.

This demo program is used by 8K series DO modules.
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Demo

gk_dio

Explanation

Shows how to read the DI and the DO values of the
DIO module.

This demo program is used by 8K series DIO
modules.

87k _basic

Shows how to send/receive a command/response
application.
This demo program is used by 87K series modules.

87K_demo

Shows how use uart APl and the 10 modules located
as slots.
This demo program is used by 87K series modules.

87k_ai

Shows how to read the Al values of Al module.
This demo program is used by 87K series Al modules.

87k_ao

Shows how to write the AO values to AO module.
This demo program is used by 87K series AO
modules.

87k_di

Shows how to read the DI values of DI module.
This demo program is used by 87K series DI modules.

87k _do

Shows how to write the DO values to DO module.
This demo program is used by 87K series DO
modules.

87k_dio

Shows how to read the DI and the DO values of the
DIO module.

This demo program is used by 87K series DIO
modules.

7k87k_basic

Shows how to send/receive a command/response
application.

This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87K_ai

Shows how to read the Al values of Al module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_ao

Shows how to write the AO values to AO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_di

Shows how to read the DI values of DI module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.
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Folder Explanation

Shows how to write the DO values to DO module.
7k87k_do This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
Shows how to read the DI and the DO values of the
DIO module.

This demo program is used by 7K or 87K series

Al modules which connected through a COM port.

7k87k_dio

For C# application, these demo programs can be obtained from:

» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\Demo\WIinPAC\DotNET\C#.NET\PAC_IO\

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/demo/winpac/dotnet/
c%23.net/pac io/

» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\DotNET\C#.NET\PAC_IO\

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/demo/winpac/dotnet/
c%23.net/pac io/
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ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/demo/winpac/dotnet/c%23.net/pac_io/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/demo/winpac/dotnet/c%23.net/pac_io/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/pac_io/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/pac_io/

5.2. Demo Programs with eMbedded Visual C++

The following eVC demos have been designed to demonstrate the various
features of the WinPAC.

5.2.1. eVC Demo programs for WinPAC Standard API

The table below describes the WinPAC demos that have been designed to
demonstrate the standard operation features of the WinPAC.

| System Information — Watchdog

| Backplane Access — UART

Interrupt — Registry

Memory Access — Micro SD
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WinPAC Standard API:

Explanation

Retrieves information about the OS

system Systeminfo version, CPU version, SDK version,
etc.
. Retrieves information about the DIP
backplane Backplaneinfo _
switch, backplane ID and slot count.
Shows how to read/write date values
Memory
from/to EEPROM
memoryaccess

Shows how to read or write to the

battery_backup_sram
V= S battery backup
watchdog watchdog Displays how the watchdog operate

Shows how to enables/disables
Micro SD

Shows how to read/write date values
from/to registry

microsd microsd_management

reqgistry registry

Shows how to read the name of

uart dia
g local I/O modules via UART

For eVC application, these demo programs can be obtained from:

>» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\Demo\WinPAC\eVCT\Standard\
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/demo/winpac/evc/sta
ndard/

>» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\eVC\Standard\
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/demo/winpac/evc/sta
ndard/
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ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/demo/winpac/evc/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/demo/winpac/evc/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/standard/

5.2.2. eVC Demo programs for PAC 10 API

The table below describes the WinPAC demos that have been designed to
demonstrate the expansion I/0O module features of the WinPAC.

Local I/O

PAC 10 API:

Shows how to retrieve the module names and types

find_io . : :
- which plugged in the WinPAC.
_ Shows how to read the DI values of DI module.
Local 8k _di ) . :
This demo program is used by 8K series DI modules.
8k do Shows how to write the DO values to DO module.

This demo program is used by 8K series DO modules.
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Demo

gk_dio

Explanation

Shows how to read the DI and the DO values of the
DIO module.

This demo program is used by 8K series DIO
modules.

87k _basic

Shows how to send/receive a command/response
application.
This demo program is used by 87K series modules.

87K_demo

Shows how use uart APl and the 10 modules located
as slots.
This demo program is used by 87K series modules.

87k_ai

Shows how to read the Al values of Al module.
This demo program is used by 87K series Al modules.

87k_ao

Shows how to write the AO values to AO module.
This demo program is used by 87K series AO
modules.

87k_di

Shows how to read the DI values of DI module.
This demo program is used by 87K series DI modules.

87k _do

Shows how to write the DO values to DO module.
This demo program is used by 87K series DO
modules.

87k_dio

Shows how to read the DI and the DO values of the
DIO module.

This demo program is used by 87K series DIO
modules.

7k87k_basic

Shows how to send/receive a command/response
application.

This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87K_ai

Shows how to read the Al values of Al module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_ao

Shows how to write the AO values to AO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_di

Shows how to read the DI values of DI module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.
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Folder “ Demo Explanation
Shows how to write the DO values to DO module.
7k87k_do This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
Shows how to read the DI and the DO values of the
DIO module.

This demo program is used by 7K or 87K series

Al modules which connected through a COM port.

7k87k_dio

For eVC application, these demo programs can be obtained from:

» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\Demo\WinPAC\eVC\PAC_IO\

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/demo/winpac/evc/pa
c io/

» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\eVC\PAC_I0O\

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/demo/winpac/evc/pa
c io/
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ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/demo/winpac/evc/pac_io/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/demo/winpac/evc/pac_io/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/pac_io/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/pac_io/

6. WInPAC Updates

This chapter provides instructions on how to upgrade WinPAC OS and SDK.

ICP DAS will continue to add additional features to WinPAC SDK and OS in the future, so
we advise you to periodically check the ICP DAS web site for the latest updates.

WinPAC updates services can be divided into the following two main categories:

CD: \Napdos

wp-8x3x_ced0wp-8x4x_ced0

: llllllll) 1. Osupdates
0S_Image

eboot

update_from_Eshell

update_from_file

ﬂ-----------------) 2 SDK updates

m O _Modules

m NAPOPC_CE5S

= WinconSDK

= WinPacNet

m WinpacSDK

WinPAC User 8000 Manual, version 2.0.7.  Last Revised: October 2012  Page: 131

Copyright © 2009 ICP DAS Co., Ltd. All Rights Reserved. = E-mail: service@icpdas.com



6.1. OS updates

The updates files of OS image are located on:
» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\0S_Image\

>» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\0S_Image\

CD: \Napdos

wp-8x3x_ced0/wp-8x4x_ced0

0s_image

update_from_Eshell

update_from_file

There are two ways to update the OS:
1. Update from file (Please refer to section 6.1.1)

(We recommend that you use this one for more quicker and easier to update)

2. Update from Eshell (Please refer to section 6.1.2)

OS_image

Update_from_eshell

L Update_from_files

E
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The WIinPAC OS supports multi-language:
1. en - English
2. sc - Simplified Chinese

3. tc - Traditional Chinese

0s_image

I

update_from_file update_from_eshell
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6.1.1. WinPAC OS updates using installation package file on WinPAC

Installation package is easier to upgrade OS image, you just copy the package file
(.exe) and the corresponding “Autolnit.bat” file to WinPAC, and then double-click
installation package file to run it.

U
Installation package file
& Autolnit.bat¥ile

Below is a step by step procedure for updating the WinPAC OS.

Step 1: Get the latest version of the installation package file and the
corresponding “Autolnit.bat” file downloading to WinPAC

The latest version of the installation package file and the corresponding “Autolnit.bat”
file can be obtained from:
>» For WP-8x3x series

CD:\Napdos\wp-8x3x_ce50\0S_Image\update from_file\

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/o0s image/update from
file/

» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\0S_Image\update from_file\

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/os image/update from
file/
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http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/update_from_file/

The corresponding “Autolnit.bat” file can be obtained from the same folder.

There are several ways to download the installation package file and the
corresponding file to WinPAC:

i. On the WIinPAC, you can download these files via Ethernet connection.

ii. On the PC, you can download these files via .a USB storage device, the removable
Micro SD card or FTP server

Step 2: Run the installation package file and then click “OK” to make sure

you receive the important notice of this procedure will ease flash
memory

Warning !

Updating OS5 irmage will erase flash mernory |
Please don't turn off the device during updating |
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Step 3: Click “Update Now” to start the process

WP-8x4x Ver, 1.4.1.0

WinPAC - 8000 Update
Step 1: Install Boot Loader file |

Step 2 Erase flash disk |
Step 3: Install OS image |

Step 4: Set and save registry |

QUIT

Step 4: Click “Yes” to make sure you ready to start the process

@ Are youl sure to update your device ?

-

This installation procedure will perform the following tasks:

i. Install boot loader file

Important Warnings

Q Be careful, if the boot loader broken off in this step and cannot
restart in safe mode, you have to send it back to us.

ii. Erase flash disk
iii. Install OS image
iv. Set and save registry
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Tips & Warnings

.ﬁ This procedure will reset the registry settings to their default settings,
and all of your settings will be lost.

During this time, do not turn off the WinPAC. If the update is
cancelled before completion, the WinPAC may become damaged
and may require servicing or exchange.

Besides, we recommend that you turn off all other applications
before starting to upgrade the OS.

Step 5: After completing the above-mentioned tasks, the “Warning !” dialog
box will appear as follow, before clicking the “OK” button, you must
first turn the rotary switch to the “0” position

Reboot this device right nowy |
Please turn the rotary swithc to O - normal mode,
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Step 6: Check the WinPAC OS version

Start the WinPAC Utility, and then select the “System Information” tab to check the
current OS version.

Registry | Config Setting | Netwark Setting || System Information | Auto Execution | Backward co_| »

Siot 0: :l Serial Number: [01-89-84-31-11-00-00-80

Skot 1: :l OS Version: [104.1
: |:| Eboot Version:

Check the
OS version
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6.1.2. WIinPAC OS updates using Eshell via Ethernet

By default, the OS updates via LAN1.
Therefore, to update the OS image, make sure
LANL1 is connected to the PC.

Below is a step by step procedure for updating the WinPAC OS.

Step 1: Get the latest version of the WinPAC OS image

The latest version of the installation package can be obtained from:

» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\0S_Image\update_from_Eshell\
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/0s_image/
update from_Eshell/

» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\0S_Image\update from_Eshell\
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/0s_image/
update from_Eshell/
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http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/os_image/%20update_from_Eshell/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/os_image/%20update_from_Eshell/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/%20update_from_Eshell/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/%20update_from_Eshell/

Step 2: Run the ESHELL on the PC

ESHELL you can be obtained at:

E-HELL

>» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\PC_Tools\
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/pc tools/

>» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\PC_Tools\
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/pc tools/

Step 3: Configure the reboot in OS update mode

Turn the rotary switch to “3”, and then reboot the
WinPAC.

Step 4: Select the device which you want to update the OS image

After starting the ESHELL software, the “Select Device” dialog will appear, and
then select the device which you want.

Select Device El

Enter Device Mame: K.
[WwWINPAC270_535
Cancel |
Or Select From the List
WRPACZTD 535 Reset devices to
autornatically put

names on the
[ist.
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Step 5: Select the latest version of the OS image file

¥ Microsoft Windows CE Debug Shell - WINPAC270_636_. [= |[B1][X]

Edit Toolz Optong View Help

i EWE Curgent Log &s.. Chl+3 jﬁl 4 | |

Start Logging To File... ChlL
Atop Logging To File  Cl+F

Open E|E|
7 0 i @

Losk e | 5 en

.:, Voo HHO0506_Yer.1 005 enbin
select Image :_;I!.l Becen
LT
Dedidop

¥% Microsoft Windows CE Debug Shell - ¥P_4449g WinPACinapdosivp-2000_ce5010S_imageivp-23witn... [ |[5][5K]

File Edit Tools Opfions View Help

W= =]l @l -] s 7| @]
UP_u44498: Bootloader Version 1.8, IP: 18.1.8.50, MAC: @0001F@1ADD2 ]

T

Downloading ‘\\Rdfsicd_2%\WinPAC\napdosivp-2808_ce5640S_imageyvp-23wiiupdate_from_EshellieniVl
Jumping to image on UP_44498 ...
Connecting to UP_h4498 using Ethernet...

|~
|se

Ready e |
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Step 6: Once the procedure is completed, the “Warning !” dialog box will
Appear on WinPAC screen as below shown, click “No” to finish the
process

Warning! X |

Flease turn the rotary switch to O, normnal mode, and reboot the device,
Wiould you like to reboot right novwe or later?

-
1]
(53]
=
=)

Run the WinPAC Utility, and then select the “Save and
Reboot” command from the “File” menu to save the
settings and reboot the WinPAC

218 Help Configuration |

W-Mmlmmlwmw
=== Save
= FTP Setting | System | ¥

. : Save and Reboot
el L Reboot Without Save  psolution : [320% 240 o
oot L : Restare Default Settings

P— ‘ Exit

| —— w—y |

l_l [ L™ LSLELIN | L |} S tt

\ J, Always On Top =ting
Change HTTP document rook directory to:
|\.windcuws\.www\.wwwpuh\. | [ ] [SEtting ]
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Step 9: Click “Yes” to reboot the WinPAC

® Would you like to save the setting and reboot the device ?

Step 10: Check the WinPAC OS version

Start the WinPAC Utility, and then select the “System Information” tab to check the
current OS version.

Registry | Config Setting | Network Setting || System Informabon | auto Execution | Backward co_<| »

Skto: [ ] serial Number: [o1-85-84-31-11-00-00-80

Skat 1: |:| OS Version: [1.0.4.1

Skt 2: . : |1.0.4.13

Check the
OS version

|
|
|
|
2 |
|
|
|
|

< y
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6.2. SDKs Updates

The updates files of SDK are located on:

» For WP-8x3x series
CD:\Napdos\wp-8x3x_ce50\SDK\

>» For WP-8x4x series
CD:\Napdos\wp-8x4x_ce50\SDK\

CD:\Napdos

wp-8x3x_ced0/wp-8x4x_ced0

IO_Modules

NAPOPC_CES

WinconSDK

WinPacNet

WinpacSDK

By eVC and donet development tools, the WinPAC SDK installation is divided into the
following two parts:

i. WIinPAC SDK updates for dotnet
ii. WinPAC SDK updates for eMbedded Visual C++
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6.2.1. WinPAC SDK updates for C# or VB.net

To determine the SDK version that is compatibly running on the WinPAC, you can
read the “Release Note” which is located under each SDK folder, these files
provides important updated information for what we fixed and added.

Step 1: Get the latest version of the C# or VB.net components

The latest version of the C# or VB.net components can be obtained from:

» For WP-8x3x series
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/sdk/winpacnet/

» For WP-8x4x series
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/sdk/winpacnet/

Step 2: Copy the latest version of DLL to Host PC and WinPAC
The DLL files on Host PC are located at anywhere only the solution can reference
it.

The DLL files on WIinPAC are located at the same directory as the .exe file.
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http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/sdk/winpacnet/
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6.2.2. WinPAC SDK updates for eMbedded Visual C++

To determine the SDK version that is compatibly running on the WinPAC, you can
read the “Release Note” which is located under each SDK folder, these files
provides important updated information for what we fixed and added.

Step 1: Get the latest version of the eMbedded Visual C++ components

The latest version of the eMbedded Visual C++ components can be obtained
from:

» For WP-8x3x series
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x ce50/sdk/winpacsdk/

» For WP-8x4x series
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x ce50/sdk/winpacsdk/

Step 2: Copy the latest version of header files and libraries to Host PC

The header files are located at:
C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Include\ARMV4I\
The libraries are located at:

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\

Step 3: Copy the latest version of DLL files to WinPAC

The DLL files are located at:
\System_Disk\ICPDAS\System
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7. WIinPAC Download Center

This chapter introduces the WinPAC Download Center.

Visit the WIinPAC Download Center:
http://www.icpdas.com/products/PAC/winpac/download/winpac 8000/download os ima

ges.htm

WInPAC-8000 Download Center

Naote:
When you download the software programs, you should notice if the programs conform to your

machine. The published date and indicated requirement of a8 program can help user to determine
the compatibility for your WinPAC-8000. Before you download any program, please read the notes of

each online program first to avoid the confused situation.

r

OS imsges T WinPAC SDK T Utility & Tools T Dema T Documsnts T System Dick 1

Hote:
User should consider the suitability over his spplication. If you get any problems caused by

updating the WinPAC Utility software, please feedbads to your local seller and ask essentisl help &

savices.
WinPAC Utility

(7] (7]
2011 Jul. 2005 WP-Baxdx / WP-Bx3x - I - I

Tools to save [ view the system information registry and setup the HTTR / FTP path and updats
non-vaolatile internal memory within WinPAC-8000

The following update categories are available from the WinPAC Download Center.
v' OS images Includes updates and the latest version of WinPAC OS.

v WinPAC SDK Includes updates and the latest version of each WinPAC component
SDK, such as WIinPAC SDK, NAPOPC_CES5 SDK, Modbus SDK, etc.

v Utility & Tools Includes updates and the latest version for WinPAC toolkits
v Demo Includes all related WinPAC demos.
v Documents Includes updates and the latest version for related WinPAC documents.

v/ System Disk Includes updates and the latest version for WinPAC toolkits
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Appendix A. Frame Ground

Electronic circuits are constantly vulnerable to Electro-Static Discharge (ESD), which
become worse in a continental climate area. Some [-7000 ,M-7000 and 1-8000 series
modules feature a new design for the frame ground, which provides a path for bypassing
ESD, allowing enhanced static protection (ESD) capability and ensures that the module
is more reliable.

The following options will provide a better protection for the module:

The 1-8000 controller has a metallic board attached to the back of the plastic basket as
shown in the Figure 2-1 below. When mounted to the DIN rail, connect the DIN rail to the
earth ground because the DIN rail is in contact with the upper frame ground as shown in
the Figure 2-2 below.

Attach to DIN Ralil

/_E_._E_
Sn .

(&S

Connect to the
Earth Ground
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Appendix B. Redundant Power

The WinPAC provides two power inputs that can be connected simultaneously to live DC
power sources. If one of the power inputs fails, the other live source acts as a backup to
automatically support the WinPAC’s power needs.

The WInPAC provides relay contact outputs to warn technicians on the shop floor when
the power fails.

+24VDC Power Supply

Back-up Power Supply

PWR1

Relay Output
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Appendix C. I-8K and I-87K Modules

There are 1/4/8 slot options to expand local I/O. And the 1/O modules can be parallel bus
type (high profile I-8K series) and serial bus type (high profile 1-87K series).

The difference between them is

8K Series 167K Series

Microprocessor No Yes (8051)
Communication interface Parallel bus Serial bus
Communication speed Fast Slow

DI latched function No Yes

Counter input (for digital input module)  No Yes (100 Hz)
Power on value No Yes

Safe value No Yes
Programmable slew-rate for AO module No Yes
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Appendix D. Application of RS-485 Network

The RS-485 length can be up to 4000 ft or 1.2 km over a single set of twisted—pair cables,
if the RS-485 network is over 4000 ft or 1.2Km, the RS-485 repeater must be added to
extend the RS-485 network.

D.1. Basic RS-485 Network

The basic component of the RS-485 network consist of a Master Controller (or using a
PC as a host controller), and some RS-485 devices.

—
-
-

= ==
| R

| 232/485 Converter
(7520 Series)
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D.2. Daisy Chain RS-485 Network

All RS-485 devices are wired directly to the main network, If the network is up to 1.2 km,
it will need a repeater (7510 series) to extend the network length.

232/485 Converter 485 Repeater 485 Repeater
(7520 Series) (7510 Series) (7510 Series)

—_—
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D.3. Star Type RS-485 Network

There are branches along the main network. In this case, it is better to have a repeater
to isolate or filter the noise that is made by devices.

— ||

2327485 Converter
(7520 Series)

485 Repeater
(7510 Series)

485 Repeater
(7510 Series)

485 Repeater
(7510 Series)

- g
- g
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There is a better choice to use 7513 as a RS-485 hub on start type network.

-
u
|
L)
232/485 Converter
(7520 Series)

- g

485 Hub

I T T
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D.4. Random RS-485 Network

There are branches along the main wire. In this case, it is better to have a repeater to
isolate or filter the noise that is made by devices.

-
___I
1 L]

232/485 Converter 485 Repeater

(7520 Series) (7510 Seres)
|
485 Repeater
(7510 Series)
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D.5. Master/Slaves Settings

The RS-485 network based on master-slave architecture consists of a single master
device and one or more slave devices.

The WIinPAC provides two RS-485 communication interfaces based on the
master-slave system architecture, all of which have a pull-high/pull-low resistor, user
can set it to master or slave for implementing an RS-485 multi-drop network.

One of the RS-485 communications, COMZ2, its pull-high/pull-low resistor located on

power board, the other, COM3, located on the right side and its pull-high/pull-low
resistor located on the bottom of the right side, as shown below.

JP1 and JP2 are the jumpers’ settings
of the pull-high/pull-low resistor

WinPAC 8000 User Manual, version 2.0.7.  Last Revised: October 2012  Page: 156

Copyright © 2009 ICP DAS Co., Ltd. All Rights Reserved. = E-mail: service@icpdas.com



D.5.1. WinPAC as a Master (default):

When one of WInPAC is set to master, then all the other devices on the same
network must be slave mode. If the network is up to 1.2 KM, it will need a repeater
(7510 series) to extend the network length.

Master Mode

485 Repeater
(7510 Series)

485 Repeater
(7510 Series)

Slave Mode
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When WInPAC as a master using COM2 communication interface, the
pull-high/pull-low resistor located on the power board must adjust to enable as
shown below.

NP RUlIEFowlEnable
YPR2ARUlIEHighliEnable]

When WInPAC as a master using COM3 communication interface, the
pull-high/pull-low resistor located on the power board must adjust to enable as
shown below.
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D.5.2. WIinPAC as a Slave

For most of application, when using one 7520 series as RS-232/485 converter, its
pull-high/pull-low resistors are set to enabled. Then the WinPAC-8000 and all the
other devices on this network must be slave mode (the pull-high/pull-low resistors
must be disabled).

If there are repeaters on the RS-485 network, there will be pull-high/pull-low
resistors on both sides of the repeaters (I-7510)

2327485 Conwverter 485 Repeater 485 Repeater

' (7520 Series) (7510 Series) (7510 Series)

Slave Mode
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When WInPAC as a slave using COM2 communication interface, the
pull-high/pull-low resistor located on the power board must adjust to disabled as
shown below.

JEARRUIEFowiDisable!
U R23RUlEHighiDisable

When WInPAC as a slave using COM3 communication interface, the pull-high
/pull-low resistor located on the power board must set to “Slave” as shown below.
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Appendix E. Tips — How to

E.1. How to set up atelnet and FTP account to login WinPAC

WiInPAC Utility has an account management function that controls the user that has
access into the telnet and FTP server.

WinPAG Utility, [2.0.2.11]

File Help Configuration

[5\,rstem Setting ]Ethernet Setting | Network Setting | System Information ] Autn Execution ] rulti-serial I 4

FTP Setting |Users and Passwiord ]

FTF @gnable  (ODisable
allow anonymous () Enable (@) Disable
allow Anorymous () Enable (@) Disable
Upload

Change FTP default download directory YTemp o:

[iTemp L]
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E.1.1. Add atelnet and FTP account

To establish a new telnet and FTP account, please perform the following steps:

Step 1: Run the WinPAC Utility located on desktop

Step 2: Select the Network Setting tab,
_-m\ and then select the Users and
Password tab

A et e

R e e Step 3: Fill auser account in the User
e ] name and Password field, and then
T — |

press Add button, the user will be

added to the user account list

B[E
File Help Conh¥

[System Setting I Ethernet Setting | Metwork Setting ISyStem Information IAut: Execution ) 248

The user will be

ETP . . WIinPAC Utility [2.0.2.1]
— | File Help Configuratior, ad d ed tO the user
SEF name Password
System Sett Ethi tS 1
Y T e B account list
) FTP Setting | Users and Pax
User name |Password | | Mote: _
Ecther I The accounts is uy User name Password
the servers search
FTP, WebServer ¢ :] E
L"Oser name | Password Mote:
/ Esthor pryrpry The accounts is used to login
Anna . the servers search as Telnet,
Setting \\\/ FTP, WebServer etc on WinPAC,

Step 4: Press Setting button

If the login succeeds, the dialog
will display when the user
account has been created

Login succeeds, The wsers of FTP have been enabled right now
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E.1.2. Remove a telnet and FTP account

To remove a telnet and FTP account, please perform the following steps:

Step 1: Run the WinPAC Utility located on desktop

» Step 2: Select the Network Setting tab,
,_-m\ and then select a user account from
the user account list. The user account
that you select will display in the User
name and Password field

# J Step 3: Press Delete button, the user

vasill
T y— miajape deleted from the user account
list

Bl

Fle Help Configuration

ISystem Setting IEﬁwemet Setting | Network Setting |System Information IAutD Execution IMuItrserla\ g

FTP Setting | Users and Password

User name Password

Jerra | | 4
Mme I Password‘h>
CITT
o

Sile Help Configuration
[System Setting IEﬂﬂernet Setting | Metwork Setting |System Infor mation I Auto Execution I Multi-serial| < I 4

The =_counts is used to logir FTP Setting | Users and Password L
the servers search as Telnet

FTP, WebServer etz on Winf 1k e Password

‘IAnna | H\Add ]r Delete ]
-

Settin
g Name I Password

Eother  ———— The accounts is used to login
the servers search as Telnet,
DR, e o s LI AT,

Esther

the User name and
Password file will

Select a user
account from the
user account list

display the selected
account

Step 4: Press Setting button

If the login succeeds, the dialog
will display when the user Login succeeds. The wsers of FTP have been enabled right now

account has been removed
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E.1.3. Use a Telnet to login WinPAC from PC

To use telnet to login WinPAC from PC, please perform the following steps:

Step 1: On the PC side, select Run from the start menu

Step 2: Type cmd, and then press OK button

~ ... . (PN |
_ = Type the nar!

Windovs Lpdate 3 Internet resz A%

Programs Oper: | "
Diocurnents ~
l Setti ———

E FHngs [ QK ] lwiancel l [ Browse, ., ]
j“:l Search I

apork

Help anc

Windows XP Professional

yesoft Window
copyright ]
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Step 4: Type user name and password to login

oo C:AWINDOWS System 32cmd. exe

Welcome to the Windows CE Debug Service on WindowsCE

login> Anna

Step 5: The connection has been established

v CHAWINDOWS S ystem 3 2emd. exe

Welcome to the Windows CE Debug Service on WindowsCE

e T E
soedl

ket CHD w 5.8

Tips & Warnings

WInPAC Utility [2.0.2.1] CIEE]
File Help Configuration

ISystem Setting I Ethernet Setting | Hetwork Setting |System Infor mation I Autn Execution ]Multi—serial| [»

i If you can’t login, please check that the FTP setting is enabled.

FIB-3eting |Users and Pagsword |

[ Fre : (/) Disahle
aletnonymous () Enable Disable

Allow Anonymous (D) Enable Disahle
Unload

Change FTP default download directory YTemp to:

WTemph, ‘ E
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E.2. How to online debug WinPAC

Debugging is a process that you use to find and resolve errors, or bugs, in a program.

E.2.1. Debug WIinPAC programs in EVC++

Step 1: On the “Tools” menu, click “Configure Platform Manager...”
command

| File Edit Yiew Insert Project Build 'Iools Window Help

2 Error Lookup

7% Remote Call Profiler (WCES00)

2 Remote File Viewer (WCES00)

7% Remote Heap Walker (WCES00)

2 Remote Kemel Tracker (WCES00)

% Remote Pexformance Monitor (WCES500)
% Remote Process Yiewer (WCES00)

7% Remote Registry Editor (WCES00)

7% Remote Spy++ (WCES00)

/b Remote System Information (WCES00)
% Remote Zoomin (WCES00)

Select Remote Tools 4
Customize...
Options...

35 Macro...
Record Quick Macro Ctel+Shift+R
Play Quick Macro Ctel+Shaft+P

Configure Platform Manager...
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Step 2: On the “Windows CE Platform Manager Configuration” dialog, click
the “Properties...” button

Windows CE Flatform Manager Confignration

Select a platform or device to configime

- @ PACZTO Add Device |
% PACT0 Device
+ @ 5A_IA |

¥ @ STANDARDEDE 420
+ @ Windaws CE Default Platform

oK

Step 3: On the “Device Properties” dialog, click the “Configure...” button

Device Properties

Dieveice Name:
PACZTO Device

Select a tramsport and & stactop server. Choosze Test to werifsy that o can
establizh & connection to wour target device with the selected transport and

startup server

Tranzport:

| TCP/IP Transport for Windows CE ~ | |iChntigE
Btartop Server:

|Ma.nu5.1 REIVET ﬂ Configore. .
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Step 4: On the “TCP/IP Transport Configuration” dialog, select the “Fixed
port” check box, and then click the “OK” button

TCEP Transport Confignration

Configuration far device:
FACZSO Device

| Check connection status Interval [meec): |

W Fixed port Port rumber:  [5000
Host IP
¢ Usze fived address: |1EI.EI.E|.52 j

(" Configure automatically aver zerial

n] Cancel |

Step 5: On the “Windows CE Platform Manager Configuration” dialog, click
the “Test” button

Device Properties

Device Name:
PACZT0 Device

select a transport and & starbop server. Choosze Test to werifay that o can
eztablizh a connection to wour target device with the selected transport and

startup srver

Transport:

| TCRAP Transport for Windows CE »|  Configure..
atartup Server:

|Mﬂ]‘ﬂlﬂl RETVED j Configure. ..

.........................

OK | Comeel | e
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Step 6: The “Manual Server - Action” dialog will appear displaying a
command line, before click the “OK” button to close dialog, turn to
the WinPAC controller side to do the next two-steps

Mannal Server - Achion

Fleaze make sure the following files are on the device

SO0 S M epipe. il
SMWANDOWS \cemgre. exe
IO O S oetlztub, il

And launch CEMGRC.EXE with the following cmd line

CEMGRC.EXE /S /T:TCRIPC.DLL /Q /D:10.0.9.52:5000

Cancel

Step 7: On the WIinPAC, select the .13| “ Start” menu, and then click the
“Run...” command

b

3 Programs
7 Favorites  »
) Documents
[ Settings

& Help

’ )

v

v
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Step 8: On the “Run” dialog, type the command which displays in step 6 and
then click the “OK” button

() W

My Device WINPAC ...

=

Type the name of a program, folder,
or document, and Windows will open
it

a/\ 3@ for you.

Internet Microsoft :
Explorer EGEECIEEER] | :tcpipc.dil fq /d:10.0.9.52:5000 v

L

My
Docurnents

-

|Browse...| | ok |

Step 9: Return to the Host PC side, on the “Manual Server — Action” dialog,
click the “OK” button

Manmal Server - Action

Pleaze make zure the following files are on the device

WD O S bepipe. dil
Wl DO S eemgre. exe
Wl DO S heetlstub,

And launch CERMGRC EXE with the following crd line

CEMGRC.EXE /5 /T:TCRIFC.DLL /Q AD:10.0.3.52:5000

Cancel |
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Step 10: On the “Testing Device Connection” dialog, click the “OK” button

Tezshing Device Conneclion

Dievice Name:
PLCE70 Device

Connection to device established
TCEIP Transport for Windows CE

Step 11: On the “Device Properties” dialog, click the “OK” button

Device Properhes

Device Name:
PAC2T0 Device

Belect a tranzport and a startop server. Choose Test to werify that won can
establish a connection to your target desdce with the selected tramsport and

startup server

Transport:

| TCPAP Transport for Windows CE ~|  Configure..
Btartup Server:

|Ma.nu;al BETYEr ﬂ Configure. ..

.........................

8] Conesl | Test |
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Step 12: On the “Windows CE platform or device to configure” dialog, click
the “OK” button

Windows CE Flatform Manager Confignration

Select a platform or device to configime

@ Pac2in Add Device
@ PACE Device

@ sh 1k Delste

¥ @ STANDARDEDE 420

+ @ Windaws CE Default Platform

+

Froperhes...

Abont

did:

Step 13: On the “Build” menu, select the “Start Debug” command and then
click the “Go” command

File Edit View [nmit Fmoject |Buid Tools Window Help

2 Compile systeminfodlzepp  CHFT
Budld SrrstemnInto exe F7
Rebuild 411
Eatch Build....
Clean

Tpdate Remaote Cutput File(z) Tl} Step Tinto Fl1
¥ Ewecute Systemlnfoexe  CulF5  0F Runto Comor  Ci+F10

Set Active Configurstion... Attach to WCE Process...

Configurations. ..
Bet Lotive Platform...
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Step 14: The “Manual Server - Action” dialog will appear displaying a
command line, before click the “OK” button to close dialog, turn to
the WinPAC controller side to do the next two-steps

Manual Server - Action |E|

Fleaze make zure the following files are on the device

Wi/ M DOWS Stepipe. dil
WM DWW Shoemgre. exe
WM DOwS e etlztub, dil

And launch CEMGRC.EXE with the following cmd line

CEMGRC.EXE /T:TCPIFC.DLL /@ /D:10.0.9.52:2003

Cancel

Step 15: On the WIinPAC, select the “ Start” menu, B| and then click the
“Run...” command

v

) Programs
¢ Favorites  »
) Documents
[ Settings

@ Help

v

v

J
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Step 16: On the “Run” dialog, type the command which displays in step 5
and then click the “OK” button

g

My Device WINPAC ...

s

2]
Internet Microsoft
Explorer WordPad  Micros |:tcpipc.dl| {q /d:10.0.9.52:5000 v

=

My
Documents

8|

[Qrowse...] I OK ]

Step 17: Return to the Host PC side, on the “Manual Server — Action” dialog,
click the “OK” button

Manual Server - Action

Fleaze make sure the following filez are on the device

S IHD DWW S Skepipe. dil
W MDD O S cemare. exe
WD DS Setlztub, dl

And launch CEMGRC.EXE with the fallowing crd line

CEMGRC.EXE /5 /T:TCRIPC.DLL A3 /D:10.0.9.52:5000

Cancel |
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Step 18: On the “Manual Server - Action” dialog, click the “OK” button

Microsoft eMbedded Yizsnal C++

'CA.MARMYAIReNMemory.exe' does not contain debugging
information. Press OK to continue.

[ Do not prompt in the future.

0K Cancel

Step 19: Connection established. Then you can debug on line.

Tips & Warnings

If you want to quit the debugger and return to editing, you can click the
“Stop Debugging “button from “Debug” menu

Eile Edit View Insrt Project  Debug Layowt Tools Window Help

_Eég Exceptions...

Maodnles...
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E.2.2. Debug WIinPAC programs in Visual Studio 2005/2008

Debugging in Visual Studio 2005/2008 are provided by WinPAC OS image V
1.3.0.4 or later.

Step 1: Make sure the following file are listed with the matching version
numbers

C:\Program Files\Common Files\Microsoft 1. ActiveSyncBootstrap.dll
Shared\CoreCon\1.0\Bin 2. ConMan2.dll

3. ConManPS.dll

4. DesktopDMA.dII

5. eDbgTL.dll

6. TcpConnectionC.dll
C:\Program Files\Common Files\Microsoft conmanui.dll
Shared\CoreCon\1.0\Bin\1033
C:\Program Files\Common Files\Microsoft 1. DeviceDMA.dII
Shared\CoreCon\1.0\Target\wce400\armv4i = 2. eDbgTL.dll

3. TcpConnectionA.dll

4. clientshutdown.exe

5. CMAccept.exe

6. ConmanClient2.exe

Step 2: If the version matches correctly and the entire file are there, copy the
following files to WinPAC:\ System_Disk\ICPDAS\System folder

v Clientshutdown.exe
v ConmanClient2.exe
v" CMaccept.exe

v eDbgTL.dll

v TcpConnectionA.dll
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Step 3: On the “Project” menu, click “[Project Name] Properties...”
command

File Edit Wiew | Project | Build Debug Data Format  Tools Window  Commuonity Help
Add Windows Form...
Add Teer Contol...

Add Compopent...

Add Class... Shaft+ AlHC
Add New Ttem... Ctrl+Shiftd
Add Existing Ttem...  Shift+ Alt+4

EE & B e

Emclnde From Project
whow All Files

IIEE'

Add Beference...
Add Web Eeference...
st az StartlUp Project

Change Target Platform...

mystermnlnfo Properties. .

Step 4: On the “SystemInfo*” tab, unselect “Deploy the latest version of
the .NET compact Framework (including Service Packs)” check box

create_database®  Formlcs | Forml .cs [Design] Object Browssr - X
Application
Build [%
sployment Options -~
Build Events ) i
Target device:
Debug PACSO-AEMVA: ARMVAL Fe

Jutput file folder:
| SCEIDL _PROGEAM FILES%vcreate databas

Resources

Reference Paths ] Deploy the latest version of the NET Compact Framework (incloding Service Packs)

Signing thenticode Signing
[] Bign the project output with this certificate

Devices®

[
|
<
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Step 5: On the “Tools” menu, click “Options...” command

File  Edit ¥iew Pmogect Buidd  Debwg  Data | Toolz | Test  Window Help

A~ -G J o f a9 - | | Atechio Broces.. Cl+AlHP v
PACS0-ARMYV4: ARMV4I Release  ~ 8l 53 17 8 Device Secuity Manager..
?3_ create_database® Formi cs | Forml cs [Desig] E]? Connect to Device...
= . E]? Device Emulator Manager...
(=]
E" Application ‘ﬂ; Connect to Databaze. .
Euild ‘g Cormect to Server...
AT [ Code Snippets Manager.. Ctd+k, Ctil+B
Build Events
Target device: Chooz Toolbox [tems...
Debug FACSO-ARMV4: ARMVAL Add-in Manager... T
Jutput file folder:
s _'%::pSIDL PROGRAM_FILE Hocios g
| - - Partier Products Catalog
Reference Paths ]
[] Deplox the latest version Crate GUID ksh
Signing thenticode #Hgning Dotfuzcator Commumnity Edition
Dovicos* L] Sign the project outputw 3 WCF Service Confignration Editor
External Tools..
Lmnport and Export Settings...
Cuztorize. ..
Options...
< == N >

Step 6: On the “Options” dialog, select “PAC 270” from the “Show devices
platform” list, and then click the “Properties...” button

Documents

Find and Replace

Fonts and Colors L
Help Devices: %

Tmport and Export Jethings B CN L DR A AT AT B oloeen

Intemational Sath PACS0-ARMVS: ARMYVAL Rel

Kevhoard
o

Tazk List
Web Browser Lelete

Projects and Bolutions -

S ot
Text Editor
Database Tools

Debugging =

Dwgzni?:_lls Defanlt dewvice:

Dievices PACS0-ARMVY: ARMVAL Releas w |
Foom Factors

>

Show devices for platform:

e
PACETN

[0 (-

[ £

[ oK || Concel |
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Step 7: On the “PAC50- ARMV4:ARMV4I_Release Properties” dialog, click
the “Configure...” button

FACSO-ARMY4: ARMYA4I Release Properties

Diefanlt output location on device:

| Frogram Files Folder w |
Transport:

| TCP Comnect Transport v| Confignre... |
Bootstrapper:

|P;c1ive$:m: Startup Provider w | Configre...

[ |Detect when device 1= disconnected:

OK ﬁ | Cancel

Step 8: On the “Configure TCP/IP Transport” dialog, select the “Use specific
IP address” option and type the IP address of WinPAC, and then
click the “OK” button

Documents
Find and Feplace
Fonts and Colors
Help
Import and Export Settings

[

Show devices for platiorm:

PACGN-ARMYA ARMTAT Raleace

y Configure TCF/IF Transport

Proiecd || e fixed pourt number:
R

[T):L’QhEa Device I addes

DY () Obtain an IF address automatically using ActiveSyme

G
D: (%) Tge specific IF address:

Fo
T 10.09.43 w

| 0K || Cangel
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Step 9: On the “PAC50- ARMV4:ARMV4I_Release Properties” dialog, click
the “OK” button

FACSO-ARMYA: ARMYAI Eelease Froperties

Defanlt output location on dewvice:

| Program Files Folder w |
Tranzport:

| TCP Comnect Tramsport v Configure... |
Bootstrapper:

|Acﬁve$ym Startup Prowider W | Configure...

[ Detect when device t= discomecied;

|  OK Lé[ Cangel

Step 10: On the “Options” dialog, click the “OK” button

Dacmments
Find and Replace
Fonts and Colors PACZTO v |
Help Devices:
Import and Export Settings o
Intemational Sethings
Eevboard
Btartup
Task List
TWeb Brovwser
Frojects and Solutions
Source Control
Text Editor
Databaze Tools
Debugging =
Devg:ni?:lls Defanlt device:
Dievices PACS0-ARMVSA: AEMV4] Releas w |
Form Factors

[

Zhow devices for platform:

O-E-E-E-E-8

£
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Step 11: On the WIinPAC, run the “CommanClient2” and the “CMAccept.exe”
applications which is located at: \System_Disk\ICPDAS\System

| File Edit View Go | IjE3
RDEE E =R

; Agdress|'\.'3ystem_Disk\ICPDAS'\'3\,fstem

TepConne...  eDbgTL  ConmancCh,..  ConMan2  CMAaccept  clientshut...

o @ & (8] & 9

wWinconsDE. WINPAC_,..  PACB17Z PaCe050 PACE024 pacg017H

olece400d  OLECE400 mfcced00d  MRFCCE400

— \ e

| <€

Step 12: On the “Tools” menu, click “Connect to Device...” command

File Edit ¥iew Pooject Build Debug  Data | Tools | Window Comwoundity  Help
Sk Attach o Process . Ctel+ A1H+P

g];. Connect to Dewvice.

ﬂ Conmnect to Databass
E Connect to Server...
(5 Code Snippets Manager.. Ctl+k, Ctl4B
Zhoose Toolbox Items...
Add-in Manager...
Macrosz 4
Create GUID
Dotfuscator Community Edition
External Tools. .
Eﬁ‘ Device Emmlator Manager...
Impont and Export Sethings.
Customize. ..

ptions...
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Step 13: On the “Connect to Device” dialog, select “PAC 270” from
“Platform” list and then click the “Connect” button

Connect to Deyice
To connect to a phardcal device or lavnch an emulator tmage, s=lect a

platform, then choos a device belowe. k

Blatform:

s
PACIT

v|

Dievices:

Step 14: On the “Tools” menu, click “Connect to Device...” command

y

To PACE0-ARMYA: ARMVAL Release'
Connection scceeded .

Step 15: Connection established. Then you can debug on line.
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FAQ:

If the connection fails shown as follow, return to step 11 to do the action
below

To PACSO-ARMYA: ARMVAL_Releam'
Connection failed, Sctived e 1z not installed .

Open the command prompt, run the
“CommancClient2.exe/transport:tcpconnectiona.dll/property:port=5000/id:Con”
at: \System_Disk\ICPDAS\System, and then run the “CMAccept.exe”

Al [t e|m g @
| File Edit Help |

gysten_disk\ icpdas) systen> Conmanclienti.exe /transport:tocpoonnectiona.dll /pro
perty:port=5000 /id:Con
gysten_disk\ icpdas) systems

[ Confignre TCPAIP Transport

Usze fized port number: 5000

Device [P address
O Obtain an IP address automatically using ActiveSyne

@ Uze specific 1P address:
10.0.9.10 v/

OK | l Cancel ]
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E.3. How to recompile WinCon programs

To recompile Wincon programs to run on WinPAC, certain components of the programs
require an adjustment that divides into two parts:

1. Compiler old programs which ran on Wincon 8x3x and 8x4x
2. Modify .vcp file to upgrade the old WinCon project

Tips & Warnings

Aﬁ In general, you only need to do part 1, after this, if the program still
can’t be compiled to an application, the part 2 just need to do.
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E.3.1. Compiler old programs which ran on Wincon 8x3x and 8x4x

Step 1: Open project which programmed in WinCon using eMbedded Visual
C++

Step 2: On the “Build” menu, click “Configurations” command

Eﬂe Edit View [nwmit Project | Build Layout Tools Window Help

BEuild HELLO exe F?
Eebuild A1

Batch Build ...

Clean

atart Debug 3
Tpdate Femote Cutput File (z)

Execute HELL O exe CHIHFS

set Active Configiration. ..

Configurations...

get Active Platform. .

Step 3: Make sure the CPU type is “STANDARDSDK”

. Demo - Microsoft eMbedded Yisnal C++ - [DemoDlg.cppl El@|gl
[ Fil: Edit View [Insert Project Build Tools Window Help
S sH@ L e o ME® @ MIE™
ICDemuDIg jl[ﬁll class memhers]j| § OnButtonAO j v
|Demo - | SENGIGOENAE - | (Win32 (WCE ARMVA) Release  ~||STANDARDSDK_420 Emulator  ~|
Al TCHAR temp[28],*stopstring; ﬁ
float AO[A];

+ (1 Demo resources int s

n_A00.GetWindowText(temp, 20);

WnPstring);
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Step 4: On the “Configurations” dialog, click the “Add...” button

Configurations

Projects and Close
--Demo
Win32 [WCE emulator] Release Add...

Win32 (WMW'CE emulator] Debug

Bemove
Win32 (WCE ARMYV4] Debug

Winl2 (WCE x86) Release

Win32 (WCE x86) Debug

Step 5: On the “Add Project Configuration” dialog, choose one of the CPU
type and then click the “OK” button.

Add Project Confignration

CPU: 0K
\Win32 (WCE ARMVYAI) |

Cancel

Copy settings from:

|*Default Debug Configuration j

Confiquration:

|Fle|ease

The new configuration will be called:
Demo - Win3d2 WCE ARMVYAI] Release
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Step 6: On the “Project” menu, click “Settings...” command

[ File Edit View [Insert Project Build Tools Window Help

met Active Project »
Add To Progect »

mettings. . A4ET
Export Makefile. ..

Insert Project into Workspace...

Step 7: On the “Project Settings” dialog, select the “Link” tab and change
the value of the “Entry-point symbol” field, “WinMainCRTStarup” to
“wWinMainCRTStartup”,

Project Settings

Settings For: General ‘ Debug | ClC++ | Link | Resources | M EE
Win32 (WCE ARMVY4) Release -
Win32 W ‘ | Cotegory: (TN -] Reoc
:
Base address: Entry-point symbol:
000010000 'wWinMainCRTStartup

Stack allocations
Reserve: Commit:
0x10000 |0x1000

Yersion information

Major: | |

Project Options:

UARTCE.lib I7000CE.lib /nologo /base0x00010000" A
fstack:0x10000,0x1000 lentry"wWinMainCRT Startup” —
fincremental:no /pdb:"ARMYA4Rel{Demo.pdb"

| £

1] Cancel
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Step 8: After performing above-mentioned steps, build the project, your
project should build success. If not, it will show error message as
follow. Please continue with the following steps

——

JCIaSSVICW #] ResourceYiew | E] FileView

int SIORDT3;————____
bool timerOn=false;
int DO_number=8,DI_numbet

j Linking . . .
UARTCE.lib ( UARTCE.dIl) : fatal error LNK1112: module machine type ' THUMB ' conflicts with target machine type ' ARM "

Error executing link.exe.

Demo.exe - 1error(s), 0 warning (s) -
Build / Debug % Find in Files 1 Find in Files 7 ol

Ln 11, Col 17

Step 9: On the “Project” menu, click “Settings...” command

File Edit View [nwit | Project Build Tool: Windew Help
set Active Project r
Add To Project 3

AHE?

Export Makefile. ..

[nzert Project into Workspace...

Step 10: On the “Project Settings” dialog, select the “Link” tab and change
the value of the “Project Options” field, “ARM” to “THUMB”, and

then built the project

Settings For: General | Debug | CiC++ Link ‘ Hesources | M DI
\Win32 (WCE ARMV4I) Release v | Category: [General ]

Project Qpl_iTJ_n_é:___——————__

fnodefaultlib! 'S [CENoDef=alii=ii]
fout"ARMYAIRelf 0.exe"’
fsubsystem:S[CEESubsystem] fMACHINE: THUMB

0K | Cancel
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E.3.2. Modify .vcp file to upgrade the old WinCon project

Step 1: Open atext editor to modify the .vcp file

Step 2: In the .vcp file, replace “0xa301” with “0Oxa501”

Step 3: In the .vcp file, replace “ARMV4” with “ARMV4|”

Step 4: In the .vcp file, replace “MACHINE:ARM” with “MACHINE:THUMB”
Step 5: Save the .vcp file just edited

Step 6: Open the old WinCon project and recompile it
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E.4. How to use the printer

WIinPAC have ability to access the printer, you can connect to the printer via Ethernet
network or USB.

Tips & Warnings

Q WInPAC only supports HP Laser Jet Printers which support PCL6
driver. The following printer support is released by HP

» HP LaserJet 4000 series/HP LaserJet 4100 series
HP LaserJet 2100 series/HP LaserJet 2200 series
HP LaserJet 1200

HP LaserJet 3200/HP LaserJet 3300

HP LaserJet 4200 series/HP LaserJet 4300 series
HP LaserJet 5000 series/HP LaserJet 5100 series
HP LaserJet 8000 series

HP LaserJet 9000 series printers

vV V VY VY VY VYY

If you need the latest support of HP PCL6 printer, you can refer to
following link
http://h20000.www2.hp.com/bizsupport/TechSupport/Document.js
p?objectiD=bpl04568
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E.4.1. How to use network printer

To use a shared network printer, please perform the following steps:

Step 1: On the Host PC, check the name of the Host PC and the shared printer

System Properties

| System Restore ( Automatic Updates || Femote |

General Computer M ame Hardware || Advanced |

=

Windows uzes the following information to identify your computer
an the nebwork,

Computer description: ||

For example: "Kitchen Computer or "bMarny's
L O

’/ L
( ( Full computer narne: ServerMame.
M ICELLAS

=]

To uze the Met

domain and cre
10,

& Auto HP LaserJet 2200 (RD1) on KEVIN_WINPAC Properties

General | Sharing | Parts || Advanced || Color Management || m |

To rename thiz

L, Y'ou can ghare thiz printer with ather uzers on your network, To
é&i enable zharing for thiz printer, clhick Share thiz printer.

() Do not share this prinker
Sh

: .: pl;l (8=l

\
Share name: |F'rinterN ame] )

/4 Changes —

Drrivers

If thiz printer iz zhared with ugers running different vergions of
Windows, pou may want to install additional drivers. sa that the

uzers do not have to find the print driver when they connect to
the shared printer.

Additional Drivers. .

0k ]’ Cancel ]’ Apply Help
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Step 2: On the WinPAC, open a WordPad format file

=[-8 Edit View Format Tools

= .

Cpen. .. Crl+O i
Step 3: Set up the printer

Save Ctr+5 1. Printer: PCL Laser

Save As.., 2. Port: Network

Passwiord, .

3. Net Path: \ServerName\PrinterName

Print... Ctrl+P The “ServerName” is your PC’s name or IP.

The “PrinterName” is your printer’s shared name of
your PC

a Paper Size: Select the paper size

Rerent Files 3

Close Ctrl+

[File Edit view Format Toon | @R ! & © [Tahom v [14
Test 111
Print (7] [ok] (]
Printer: [PCL Laser v Print Range Orientation
Port: [Network v Al @) Portrait

Selection Landsca
Net Path:  [URD1-User2\Anna O O i
Paper Size: l A4 _ Margins (inches)

E]DraftMode Left: |12'5 Top: |1"
Color RDht: Il'zs“ Bottom: |11

Advanced
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file://ServerName/PrinterName

E.4.2. How to use printer via USB

To use a shared network printer via USB, please perform the following steps:

Step 1: On the WinPAC, open a WordPad format file

5 :8 Edit View Format Tools

R [=30 3

Qpen, .. Ctrl+D

Save Ctrl+S Step 2: Set up the printer

SdE 1. Printer: Hewlett-Packard LaserJet

PREETILL. 2. Port: LPT1
m 3. Paper Size: Select the paper size

Recent Files :

Close Ctrl+wy

| File Edit View Format Tools " = [ 3 |Tah|:|rr| v |14 v
Test 11!
Print E
Printer: IHEW].Eﬁ-PSJ:kBId Laserh v Print Range Orientation
Part: | L1P1 v OF (@) Partrait
Net Path: | (O Selection () Landscape

Margins (inches)

[ ] Draft Mode Left: 125 Top: t
Cllr Right: |1.25" Bottom; Il"

Paper Size: | Ad

(£

Advanced
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E.5. How to use services tool

The services tool can help you turn on, turn off and monitor the WinCE services.

Step 1: Open a MS-DOS command prompt

) Programs * A
i Favorites 4
) Documents  *
[ Settings ’
i I
. e

=

Type the name of a program, folder,
or docurment, and Windows will open
it for you.

Open:
PEd

Browse... OK

[£4
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Step 2: List all services

[Syntax] services list

File Edit Help

Pocket. CHMD w 5.0
“Wr o Eerwices list
[MEY0: Qx000320110 NOTIFY.D11 Punmnirng
HTDO: Qx000321E570 HTTPD.DLL Poariridrig
CEDO: Q00032070 credsyo._dll Buntiirg
P10l - Qx00032&720 MEMQD . IM11 Off
OBX0: Ox00032ebzZ0 OBEXSrVr.dll off
FTPO: Q00037770 FTP . I11 Puarmiridrig
TELDO: Qx000327ac0 TELNETD . Ir11 Partiirug
SMEO: Ox0002c3el smbserver.dll Boariris
WTPi: Ox0002£££0 timesvo.dll Boary
o=

Step 3: Type the commands to configure service

[Syntax] services stop <services name>
For example, turn on the “FTP” service:

services stop FTPO:

WinPAC User 8000 Manual, version 2.0.7.
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File Edit Help

Pocket CMD» w L.0
“Wr serwvices stop FTPO:
“Wr services list
[MFY0: Qx00030110 NOTIFY.I'11 Purmirg
HTFPO: Qx00031570 HTTPFD.DLL Punming
CRD:O: Ox00022070 credswo.dll Puannirng
1] - Qx0003&730 MEMOQD D11 nff
OEx0: Qx00036bz0 OBEEXSrVr._ dll nff
FTFPO: Qx00037770 FTPD.D11 nOff
TELO: Qx00037aco TELHETLD .11 Purmirg
SMEOQ: Ox00023c3en smhsaerver. dll Puanning
[NTPO: OxO0002£££0 timeswco.dll Paarni
B =
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Tips & Warnings

For more information about using services tool, you just type “services
Zx help”

File Edit Help

Pocket CMD w 5.0
W+ serwices help
Commarids:

help - print this text

list - lists loaded services

load <“=service name> - actiwvabtes a serwvice that is
stop “service instance> stops/pauses a service (d
start <=service instance:> - startsfresumes & Servi
refresh <service instance> - causes service Lo re
unload <serwice instance®> - causes service to be o
register <“service name> — service will be automat
=hoot

unregister <service hnamer - service will not be =
=Xt reboot

command <service namer [argl argZ _..]1 - =send ser
0 seryice

help <zerwice name> - get information on what =se
are supported

Zzervice namer> - servwice's name in the registry
“serwvice instance> - particular instantistion |
Flags:

-f =file namer

-= silent

-d output to debugger

e |

WinPAC 8000 User Manual, version 2.0.7.  Last Revised: October 2012  Page: 196

Copyright © 2009 ICP DAS Co., Ltd. All Rights Reserved. = E-mail: service@icpdas.com



Appendix F. Revision History

Revision  Date ~ Description |
1.0 July 2008 Initial issue
1.1 August 2008 Added more information about WinPAC Utility

functions in section 3.5.

1.2 August 2008 1. Added additional information on how to establish a
new telnet and FTP in Appendix E.
2. Added additional information on how to use
services tool in Appendix E.

1.3 August 2008 1. Added additional information on how to use
network printer in Appendix E.
2. Added additional information on how to use printer
via USB in Appendix E.
1.4 September 2008 1. Added additional information on how to
automatically update the WinPAC-8000 SDK in
Appendix E.
2. Added additional information on how to manually
update the WinPAC-8000 SDK in Appendix E.
3. Added additional information on how to update the
WinPAC-8000 OS image from file
1.5 September 2008 Deleted WP-8041 information
1.6.0 July 2009 1. Changed the name of the version of this manual.
2. Moved the OS and SDK updates from the
Appendix E to the Chapter 6.
3. Added information about the multilingual interface
changes in section 2.6.
4. Added information about installing the touch panel
driver in section 2.7.
5. Added information about the Multi-serial port
wizard function of the WinPAC Utility in section
3.5
6. Added additional information about the revision
history in Appendix F.
1.7.0 September 2009 1. Added a section about the module selection in 1.2.
2. Added information about the support of the printer
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driver in Appendix E.4
1.8.0 October 2009 1. Modified the specification of the flash disk in
section 1.1 and 1.2.
2. Deleted auto mdi/mdi-x or auto mdix to Ethernet
port specification
3. Added additional information about the support of
the Micro SD socket in section 1.2.
4. Modified the printer configuration in Appendix E.4
1.9.0 October 2009 1. Added information about two new OS mode
(DCON_CE and VCEP mode) in section 2.3.
2. Replaced Quicker with NAPOPC CE5
2.0.0 November 2009 Added information about WP-8x3x series modules
2.0.1 December 2009 1. Modified the WinPAC installation in section 2.1.
2. Added information about the requirements of the
WinPAC SDK in section 4.3.
2.0.2 April 2010 1. Modified the specification of Dual Battery Backup
SRAM feature in section 1.1.
2. Added information about I/O Expansion Slots in
section 1.2.
3. Modified information about Operating Environment
in section 1.2.
2.0.3. July 2010 1. Modified information about the companion CD in
section 1.5.
2. Modified information about using Backup_ Utility
to back up the settings and files in section 2.8.
3. Added information about WinPAC tools in chapter
3.
2.0.4. November 2010 1. Added information about a caution about using
System_Disk in section 2.9.
2. Added information about the FTP setting function
of the WinPAC Utility in section 3.5.2 and E.1.
2.0.5. February 2011 1. Modified information about the WinPAC overview
in section 1.4.
2. Added information about the specification of COM
ports in section 1.4.
2.0.6. July 2012 1. Added information about COM1, COM2 in section
1.4.
2. Added information about how to use the printer in
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appendix E.4.

2.0.7.

October 2012

Modified information about the WinPAC Platform
SDKs in chapter 4.
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